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PAR/REC

PAR/REC files are the raw data as collected by the scanner. The PAR file contains parameter information about the scan – e.g. voxel size etc. and the REC file contains the recorded scan data.

VMR

VMR files represent anatomical and other single volume data in BrainVoyager

FMR/STC

Files representing functional data in BrainVoyager. FMR files contain parameter information and STC files contain the actual data. Data in FMR/STC files is represented in slices.

TRF

Transformation matrices used to change the geometry of imaging data.

TAL

Coordinates defining a bounding box known as Talairach space

VTC 

Processed functional data (time series) generated from FMR/STC files. Unlike FMR files, data in VTC files is represented as full 3D functional volumes in 3 dimensions.

PRT

Protocol file represents to BrainVoyager the order in which specifc stimuli are presented over the course of run.

RTC

Reference Time course file represents the model time course of activation for conditions which affect brain activation during a run.

GLM 

Contains the result of a General Linear Model analysis

VMP

Graphical overlay on VMR files illustrating the results of statistical analysis.

VOI/POI

Represent a specific region of interest in the brain; usually used to represent areas which have been identified by means of a functional localizer.  VOI files represent regions in volume space and POI files represent regions on a mesh.

SRF

3-dimensional mesh representing the cortical surface in the brain

SMP

Graphical overlay on SRF files illustrating the results of statistical analysis 
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The raw data you will have collected will consist of a series of PAR/REC files.

PAR/REC files are named according to the following pattern

zkXX_YYY_N_1
 
Where:
XX is the last two digits of the year in which the scan took place.

YYY is the numerical identifier for the scan starting at 001 for the first scan of the year.

N is the numerical identifier for a particular scan run in a given scan session.

e.g. ZK10_100_4_1 identifies the 4th run in the 100th scan session during 2010.

Upon returning from the scanner:

· Up-date the electronic copy of the scanning protocol sheet and put the printed version in the scanning folder.
· Burn new data (PAR/REC as a single zipped file) of one subject on a CD
· Copy the zipped data to the server under \\psg-zk-srv1\CNIL CD Backups
· Copy the PAR/REC files to the appropriate project folder on your machine along with the appropriate protocol sheet.
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Before being usable in BrainVoyager the PAR/REC files need to be converted to a format which can be used in BrainVoyager.


To process the PAR/REC files:

· Create a new folder in your fMRI data directory - the name of folder should be the same as the scan ID – e g zk10_100.
· Copy the .PAR and .REC files for the scan into this folder
· Start BrainVoyager
· From the Plugins menu select CNIL Processing Functions
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· From the dialog select Process PAR/REC files

· Select the folder which you created and which contains the PAR/REC files.

The PAR/REC files contained in the folder will be processed and a dialog box will be shown containing the details of each scan. Any scans which could not be processed will be shown with an exclamation mark in the Errors column. Clicking on any row with an error will show additional details about the error. Also see the BrainVoyager log window for additional information. 
· 
[image: ]

· For each scan you wish to process, you need to provide the scan type. In the example above the scan types for five scans have been entered. For standard scan types please refer to the table below – for your own experiments you should use a 2 or 3 letter identifier – for repeated runs of the same type you should add a suffix – e.g. for a Glass Pattern experiment use the identifier GP and for repeated runs use the scan type GP1, GP2 etc. The convention is to use all capitals for the scan type. Do not prefix the scan type with a period.

· For any scans you do not wish to process, uncheck the Process File checkbox. You will also not be able to process any files for which there are errors.

Standard scan type identifiers

	3D
	Anatomical scan 

	POL
	Polar Localizer

	ECC
	Eccentricity Localizer

	LO
	LOC Localizer 

	MT
	MTDotLoc Localizer

	KO
	KoLoc Localizer

	MST
	MTDotRet Localizer

	PL
	ParLoc Localizer

	LGN
	LGN Localizer



· Once you have selected all the scans you wish to process, click the Process button. BrainVoyager will create a new folder for each process scan and will create in each folder FMR/STC files for functional scans and VMR files for anatomical.

The naming convention which is used for identifying scan data is as follows:

All scan data will be created in folders with the following pattern

NN_ZKXX_YYY.ABC

NN is the original scan number from the PAR/REC files padded with an extra zero.

ZKXX_YY is the scan identifier
ABC is the scan type – e.g. POL, 3D etc.

Within each folder the FMR/STC and VMR files will also be prefixed with the corresponding folder name.

Any errors which occur during processing will be shown in the BrainVoyager log window.

Once the PAR/REC files have been processed, you should check the data carefully. There is a Matlab script globalVariance  which you can use for this.

To use globalVariance:

globalVariance(directory, file suffix);
Where directory is the full path to the folder where you have saved the FMR/STC files  and suffix should be the files to look for – normally this would be ‘*.fmr’

This will save a file called global variance to the session folder, double click on it to show a pdf with the runs (variance and raw time courses –averaged among all voxels). Inspect run by run and check whether there is anything odd in the data. You can also load the FMRs one by one and check the time course in each slice. This is how it should look like in the PDF:
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If you find something odd, like a big obvious drop in the signal check the other runs to see if it is a systematic problem. Spikes happening in the beginning of all runs (or most of them) might indicate that the volumes in the beginning of the run have to be removed. If that has to be done, you will have to re-import the FMRs and exclude the initial volumes, but that only if this is a systematic problem (occurs in all runs). If you find a spike that is in the middle or the end, they can be either removed or excluded from further analysis – see later in the notes for how to do this.

Rename the PDF with the suffix _raw as later you will compare the raw data with data which has been pre-processed.


· Once all PAR/REC files have been processed, create a new folder called ParRecFiles and move the files into that folder.
· 
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After processing a scanning session which contains an anatomical scan the anatomical scan will be converted to a VMR file which will be left open when processing finishes. This file will have a suffix _raw added to the file pattern described above.

Due to inhomogeneities in the magnetic field strength within the brain and distance from the receive coils the intensity of the signal from different areas of the brain is not uniform. As a result, the white matter found near the centre of the brain has a higher intensity than that found towards the edge of the brain. Intensity inhomgeneities can substantially reduce the accuracy of subsequent processing steps.

To perform inhomogeneity correction in BrainVoyager

· Open the raw VMR file in BrainVoyager if it is not already open and select the Inhomogeneity Correction, V16 Tools option from the Volumes menu.
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If the section Intensity inhomogeneity correction (IIHC) is disabled click the VMR -> V16 button at the bottom and then click Save V16. Save the V16 file with the same name as the VMR.

· Check Include mask generation
· Click the GO button.

BrainVoyager will then extract the brain from the surrounding tissue, clean up the background  and perform the inhomogeneity correction.

BrainVoyager will create a new file with the suffix _raw_IIHC.vmr – to conform to the standard convention used with previous versions of BVQX save the file again with the suffix _final.vmr and close all open files.

If you are unhappy with the results of the automatic inhomogeneity correction then it is possible to perform the correction manually. See the relevant chapter later in this document for details.
[bookmark: _Toc62411055][bookmark: _Toc366483402]Talairach Transformation

In order to be able to reliably report on locations of activation across subjects it is beneficial to transform the data to a common standard geometrical representation. 

In BrainVoyager this is done by transforming the anatomical according to a known coordinate system known as Talairach space. For more information about the Talairach transformation please see: http://www.talairach.org/about.html 

The transformation to Talairach space involves firstly aligning the brain along the plane described by the Anterior and Posterior Commissures (AC and PC points) and then identifying a further eight reference points which define the bounding box within which the brain is contained.

[image: File:Acline.gif]
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To locate the AC Point

The AC point – shown in the diagram above as the red-dot is located just posterior to the base of the lowest point of the Corpus Callosum. 

· Load  the final.vmr anatomical if not already loaded
· In 3D Volume Tools on the Talairach tab
· Under AC-PC transformation select Manual
· Click Find AC Point

· Find the AC point in lower right view and click on it so that crosshairs are centered on it, the dialog will show you the corresponding coordinates. You can Ctrl Right-Click on the lower right view to locate the point more accurately. You can also toggle the cross hairs using the A key to check the position. Once you have located the correct point before continuing Ctrl Right-Click to return the window to normal size otherwise the next step doesn’t work 

· The AC-PC line starts from the superior surface of the AC point so adjust the position until it is just above the point and just posterior to it.

· Click OK 


[image: ]


To Find the AC-PC Plane

· Click the Find AC-PC Plane button
· [bookmark: _GoBack]t
· Change the x angle, so that both commissures appear in the same plane.

The AC-PC line goes from the AC point to the centre of the Posterior Commissure so adjust the position until the point is in the centre of the Commissure.

After you change the angles, you should see both the AC and PC at the same time. You can again temporarily hide the cursors by pressing the A key.
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To align the brain to the AC-PC plane

· Click the Transform button
· leave all settings on defaults
· click GO

This will create a VMR transformed into the AC-PC plane which has the suffix _final_ACPC.vmr

To transform the ACPC brain into Talairach space

· Load the ACPC.vmr ifnot already loaded
· Open 3D Volume Tools on the Talairach tab
· Under Talairach proportional grid reference points
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· Select: AC from drop down menu
· Find the AC point and click on it
· Click Set Point

· Repeat for all the other points:

	PC
	(posterior commissure) (see above)

	AP
	(anterior point – front point)

	PP
	(posterior point - back point)

	SP
	(superior point - top top point)

	IP
	(inferior point - bottom point – make sure you include the temporal lobes)

	RP
	(right point)

	LP
	(left point)



· Choose display partial grid: check if all of the brain is in the bounding box (also helpful: ‘Show point’ to check the points you set)
· Click Save TAL and save coordinates to TAL file : _final_TAL.tal
· Click ACPC -> TAL
· Check the TAL file is set to the file you just saved
· Select Sinc interpolation	
· Click GO

This will create a VMR transformed into Talairach space which has the suffix _final_TAL.vmr.
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Reconstruction of the brain in 3D from anatomical data


The first stage in reconstructing the cortex is to segment the grey matter from the white.

· Load _final_TAL.vmr if not already loaded
· In 3D Volume Tools on the Segmentation tab choose Autom. Segm.
· Check Remove Bridges LH and Remove Bridges RH
· Click GO

The segmentation process will try to find and fill the ventricles so that they are not included in the final mesh. However, this process can go wrong with the result that areas extending beyond the ventricles are also removed from the mesh (this will be obvious as the dark green colour which fills the ventricles will ‘leak’ to the outside of the brain. 

If this occurs then the segmentation process should be aborted. 

This might be corrected by adjusting the brightness and contrast and redoing the inhomgeneity correction, if necessary do a manual inhomogeneity correction as detailed in Appendix X. If the brightness is increased very slightly so that the background image intensity is greater than zero (around 10-15) then filling the ventricles normally proceeds correctly. 

To adjust the contrast and brightness

· On the Options menu choose Contrast and Brightness
· Adjust the contrast and brightness sliders (try contrast = 38, brightness = 42 to start with).
· Save the VMR with the suffix _final_TAL_cor.vmr

[image: grey_white]During the segmentation process you must choose which intensity marks the boundary between the white and grey matter:

BrainVoyager will display an intensity histogram which should consist of two peaks corresponding to the grey matter (lower peak) and white matter.

BrainVoyager proposes a cut-off position automatically; usually it is acceptable, but you can adjust it if necessary.

If the chart does not show two clearly defined peaks then it might be necessary to do a manual inhomogeneity correction.
[image: inhomogeneity]
During the automatic segmentation you get a second graph showing grey and white matter intensities across axial slices. If the blue line is straight across the middle then the inhomogeneity correction is fine.

If you have problems with the segmentation, unchecking Remove Bridges will dramatically speed up the segmentation. Once you are happy with the results, run the segmentation again with the Removed Bridges options checked.



· If you are happy with the segmentation click OK.

BrainVoyager will reconstruct the cortex into a 3D mesh. There will be three meshes for the left hemisphere and three for the right saved in the 3D folder.

The mesh files will be suffixed with LH_RECO and LH_RECOSM, LH_WM and RH_RECO, RH_RECOSM and RH_WM for the left and right hemispheres respectively.

On the Meshes menu choose Load Mesh and load the LH_RECOSM file

· Check the results. If there are bridges then redo the cortex reconstruction, set the threshold value higher (by 3) and if there are holes redo the cortex reconstruction with a threshold lower threshold value (by 3).
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If the brain is abnormally distorted for example in senior subjects it might be necessary to manually draw on the anatomical to “block up” the leak. However, this is an advanced process – consult Matthew or more experienced lab members before you attempt this for the first time.

To manually prevent leakage on the anatomical

· Load the VMR file suffixed _TAL_LH_WM_BL2.vmr – this shows the calculated grey/white matter boundary
· In 3D Volume Tools on the Coregistration tab under VMR-VMR Coregistration click Select VMR
· Load _final_TAL.vmr
· Press F9 to overlay the grey/white matter boundary over the TAL.vmr

The white matter / grey matter boundary is represented as a yellow outline

To modify the boundary, in 3D Volume Tools on the Segmentation tab

· Check Draw with mouse: Enable
· Set Value Range: New = 255
· Set a suitable sized brush and decide whether to draw on a single slice (2D) or multiple slices at once (3D).
· Hold Ctrl and the left mouse button and draw over the anatomical region you wish to block up or hold Shift and the left mouse button if you wish to delete a region.

· Modify the anatomical as necessary which you wish to exclude
· Uncheck Draw with mouse:Enable and turn off TAL.vmr (F8) – otherwise you will get a blank mesh
· Click Reconstruction: Prepare to generate a new GM/WM boundary
· Save the file.

Once you have added or removed the parts which were incorrect you can rebuild the mesh by choosing Meshes, Create Mesh and clicking on the reconstruct button. If you get a blank mesh ensure that you have turned off the TAL.vmr first (F8)

Save the file with the suffix _final_TAL_LH_RECO.srf

To smooth the mesh:

· On the Meshes menu choose Mesh Morphing
· Choose Smoothing Mode and leave the no. of iterations to 100
· Click GO
Save the file with the suffix _final_TAL_LH.RECOSM.srf

Don’t forget to check both hemispheres.
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Once you have loaded the meshes you can navigate around the mesh as follows

· Hold the left mouse button down to rotate the mesh.
· Hold the right mouse button down to translate the mesh
· Hold both mouse buttons to scale the mesh – (move mouse away from you to shrink and towards you to grow image) You can also use Shift + left mouse button to translate the mesh and Ctrl Shift + left mouse button to scale it.
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In order to be able to optimally display functional activation on the brain it is necessary to inflate the cortex to bring sulci to the surface. 

To inflate the cortex

· Load  _final_TAL.vmr if not already loaded


· On the Meshes menu choose Load Mesh and load the _TAL_LH_RECOSM.srf
· On the Meshes menu choose Mesh Morphing 			
· Check Use Information from file and select the _TAL_LH_RECOSM.srf 
· Check Inflation mode and Update curvature coloring boxes – if you do not check Update curvature coloring or Use Information from file then you will not be able to distinguish gyrii from sulci and the inflated mesh will just look like a featureless balloon.
· Set No. Iterations to 1000
· Leave other settings on default values
· Click GO	

BrainVoyager will then inflate the mesh

To improve the definition of the Gyrii and Sulci

· On the Meshes menu choose Background and Curvature Colors
· Select Use two colors for convex and concave
· Click Smooth to improve the boundaries between sulci and gyrii and choose OK
· On the  Meshes menu choose Save Mesh and save the mesh as with the suffix 3d_TAL_LH_inflated.srf
· Repeat  the inflation for the other hemisphere
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Whilst the 3D mesh is very useful for displaying activation interactive, in order to represent activation in 2D for inclusion in a paper we need to flatten the cortex into 2D. To do this we can cut the cortex at specific points on the inside surface and “peel back” the wings to expose them on the front surface.

To cut the cortex BrainVoyager uses a reference cut along the Calcarine sulcus from the Occipital Pole to the Corpus Callosum.

To identify the Calcarine sulcus

Load  _final_TAL.vmr if not already loaded

· From the Meshes menu load the final_TAL_LH_inflated.srf mesh
· Rotate the mesh so the inside surface of the Occipital lobe is clearly visible as well as the Corpus Callosum
· Click the Select Vertex Mode button on the right side tool bar (second button from the bottom) 
· Find the Calcarine sulcus (see image below) and define five points from the occipital pole inwards, by clicking on the mesh with the left mouse button. Note that the points drawn in the image are for demonstration only and no points will be drawn on the screen.


To cut the mesh

· Choose Mesh Morphing from the Meshes menu
· Click on Auto Cut
· Check Use specified calcarine cut – click Options to view the vertex numbers for the chosen points this is useful to check that the points have been defined correctly.
· Click Apply in the Auto Cut dialog
· Click Quit in the Mesh Morphing dialog




The mesh will now be cut into coloured segments using the Calcarine cut as a reference. Save the cut mesh with the suffix _TAL_LH_autocut.srf

If the mesh disappears completely then it is likely that there is hole somewhere in the mesh and you will need to redo the segmentation to fix this.

To fix cuts by hand (if necessary)

· On the Meshes menu choose Painting and Cutting
· Check Deletion mode under Mesh drawing and filling
· Click the Draw/Cut Mesh Mode button on the toolbar on the right of the screen (3rd button from the bottom)
· Click on the mesh to define the start point of a cut, hold down Shift and click a new point to define a cut between these to point (this appears as a red line joining the points).
· Click on the Draw/Cut Mesh Mode button again to reveal the cut as a black line
· After correcting the cuts save the mesh with the suffix _TAL_LH_autocut_cor.srf

To unfold the mesh
· On the Meshes menu choose Mesh Morphing 
· Set the of iterations = 500
· Check Unfolding mode	
· Check Update curvature coloring
· Click the GO button

The mesh will now unfold from the back to the front so that the whole cortical surface is present on one side

· Save the mesh with the suffix _TAL_LH_flat.srf

At this point the mesh will have a significant degree of distortion which will need to be correct.

To check the length distortion 

· Choose Mesh Surface Functions from the Meshes menu
· Click Set undo
· Click Length distort

The mesh is now coloured according to the degree of distortion. Green areas have the highest distortion, the darker the shade of blue the less the amount of distortion. The aim of distortion correction is to eliminate the areas of green and lighter shades of blue.

· Click Undo to return to the original colour scheme

To correct the distortion in the flattened mesh

· Choose Mesh Morphing from the Meshes menu
· Check 	Distortion correction
· Set the Distortion reduction force to 0.3
· Set Number of iterations to 2000
· Click the GO button

BrainVoyager will now attempt to reduce the distortion in the mesh, you can check the progress by examining the linear distortion value in the bottom left of the window. If the linear distortion value goes to below 15, then you should not need to do another distortion correction. 

[bookmark: _Toc62411057]Check the degree of distortion again as above. If you see any bright green areas then more distortion correction is necessary. If the degree of distortion is severe it may be necessary to start with a lower distortion reduction force e.g. 0.1 and run 1000 iterations at a time gradually increasing the force until the distortion is reduced to a satisfactory amount. Save the mesh each time with the suffix _flat_cor.srf. 
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Prior to performing any real analysis on the functional data, a number of pre-processing steps should be performed with the aim of improving the quality of the data.

The pre-processing steps are

· Slice scan time correction – to correct for anomalies due to differences in the time at which specific scan slices are recorded.
· Motion correction – to correct for subject motion in the scanner.
· High-pass filtering – to correct for low-frequency signal drift caused by physiological and scanner-related noise.
· Linear trend removal – removal of continuous increase or decrease in signal over time.

To perform functional pre-processing

· From the Plugins menu select CNIL Processing Functions
· Click Pre-process FMR files

BrainVoyager will ask you to select the session folder which contains the data to be pre-processed. Select the top level folder which is named with the scan ID.

You will then be asked to select an FMR file which is to be used as a reference for motion correction. 

The reference for motion correction should be the intermediate run. For example, if you have 7 or 8 runs, chose the fourth one as a reference. 

BrainVoyager will then present a list of FMR files to pre-process. Ensure that all the files you wish to process are checked. At this point you will also be asked to provide the slice order for your scans, this will be either Ascending or Ascending Interleaved – this is important for slice scan time correction. 


IMPORTANT: For all scans acquired before 28/01/2012:

If your functional scans are 2.5mm x 2.5mm or lower then select Ascending, if they are higher resolution than this then select Ascending Interleaved. If you are unsure of which option to select then please see Matthew and/or Zoe for clarification.


For scans acquired after 28/01/2012:

Slice scan order should ALWAYS be Ascending Interleaved regardless of resolution.

If this is not clear please see Matthew of Zoe for clarification
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Select the FMRs you want to process and click OK. The script will do the rest for you. 

For reference the colours in the 3D motion correction are as follows

	Red 
	 translation in X direction 

	Green 
	 translation in Y direction 

	Blue 
	 translation in Z direction 

	Yellow 
	 rotation around X axis

	Magenta 
	rotation around Y axis

	Cyan 
	 rotation around Z axis



IMPORTANT. If you have scans with different numbers of slices in the same session you need to do the pre-processing for each group of the scans separately. In addition if after you have done the pre-processing, there is substantial head movement in any of your runs, - greater than the size of a single voxel between volumes, then you should give careful consideration about whether to split the session up and use the run where the head motion was observed as a new reference for the remainder of the session. With particularly bad data you might have to split the session up into multiple chunks.

Once functional pre-processing is complete, BrainVoyager will have generated new FMR/STC files with a new suffix made up of the following

SCCA, SCCAI (Slice scan time correction, Ascending or Ascending Interleaved)
3DMCT (3D motion correction)
LTR (Linear trend removal)
THP3c (High pass filter)

e.g. 06_zk08_099.LO_SCCA_3DMCT_LTR_THP3c.fmr

Quality control

In this step, you will check the motion correction and the quality of the preprocessing. To do that, you need to run two scripts in Matlab 

globalVariance(directory, ‘*SCCAI_3DMCT_LTR_THP3c.fmr’): This is the same script you used earlier to check the newly imported data, now you will check the variance for the motion corrected data. Trends observed in the initial data should now not be evident. Check for overall quality of the raw time course – compare it to the raw data as well. 

As the data is in the same folder, you will have to rename the other pdf (add the prefix _raw to the file) before generating this one (it will overwrite otherwise).

CheckHeadMotionSDM(‘/subj/session_folder’, 1,[],[],1): with this function, you will check the 6 head motion parameters (x,y,z rotation and translation) for each run. It will generate a figure with all your runs. Sharp motion will be tagged in this plots (the second argument is the threshold in mm). In this function, it is important that you set the current directory to be the main data directory, and the first argument to be the subj/session folder. The figure will be saved in both ppt and .fig formats. If you find motion above the voxel size, you will have to go back and do the preprocessing again using the appropriate reference. For example, if the participant moved on the fourth run, do the pre-processing from 1 to 3 using the first run as reference, and from 4 to 8 using the fourth run as reference.

A further optional step for pre-processing of functional data is spatial smoothing, this is useful for group comparison’s, however spatially smoothed data should only be used for GLM and not be used for multi-voxel pattern analysis (MVPA) techniques.

If it is decided that you should be spatially smoothing your data then see Matthew about installing the correct plugin to allow you to do this on multiple FMR’s at once.

Once you have the plugin installed, run it by choosing Batch Processing Wizard from the Plugins menu. Smooth the data by selecting Spatial filtering/Gaussian smoothing. In the FMR processing select the filter unit milimiters with a width of 5mm (FWHM width of kernel).

The output files will be suffixed with SD3DSS5 to identify spatially smoothed files.
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In order to perform statistical analysis of functional data it is important to make sure that functional datasets from multiple runs and multiple sessions are co-aligned to each other and to an anatomical reference.

The co-registration of functional (FMR) and 3D anatomical (VMR) data sets is necessary to convert the original slice-based functional data into a volumetric representation in 3D space. The transformed functional data files are called "volume-time-course files" or VTC files. 

These files contain the time course of activation for a functional scan which can be overlaid on a subject’s anatomical data. In combination with additional spatial transformation files, VTC files can be created in Talairach space to allow for analysis across multiple subjects.

The first stage in the coregistration of functional data is to align a single functional scan to a non-Talairach anatomical scan. The functional scan should be the one taken chronologically closest to the anatomical. If no anatomical scan was taken in the scan session then the first scan of the session should be used.

Because the scans for anatomical data are taken in a different orientation to functional data, we first need to re-orientate the functional data so that it lies in the same orientation as the anatomical. 

To load the FMR file to coregister

· Load the non-Talairach anatomical scan 
· From 3D Volume Tools choose the Coregistration tab
· Under FMR-VMR coregistration Click Select FMR…
· Find the folder containing the FMR you wish to align and choose the pre-processed FMR file (the one with the longest name)

BrainVoyager will display the functional data in blue overlaid on the anatomical.
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As can clearly be seen, the functional data is not in the same orientation as the anatomical

To re-orientate the functional data to the orientation of the anatomical

On the Coregistration tab of 3D Volume Tools select Align under FMR-VMR coregistration

· On the Source Options tab check Flip Slice Order
· Click the To SAG button. BrainVoyager will display the following dialog
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The aim here is to rotate the functional representation such that the SAG view of the functional data as shown is aligned with the SAG view of the anatomical.

For standard functional data the transformation is to rotate 90 degrees around the x axis followed by 90 degrees around the y axis.

· Click the X +90 button
· Click the Y+90 button

The transformed SAG view in the dialog (right hand view) should display a standard sagittal representation of the brain.
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· Cick OK
· On the Initial Alignment tab check Manual alignment use “ToSAG” matrix
· Click the Run IA button

The result should be as below.
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To help with alignment, BrainVoyager will perform edge detection to highlight more clearly the contours of the gyrii and sulci. This can be turned off by unchecking Create edge display for FMR/AMR data on the Source Options tab and clicking Create volume.

To obtain the optimal alignment the best way is to manually align the functional data with the anatomical. On the Coregistration tab of 3D Volume Tools there are controls to rotate and translate the FMR in all three axis. 

By changing the degree of rotation and translation it is possible to manipulate the FMR so that it aligns with the anatomical. To understand the action of transformation on each axis, it can be helpful when transforming the FMR to consider how the transformation would affect your own head.

To this end the transformations would correspond thus

	Axis
	Translation
	Rotation

	x-axis 
	Side to side
	Nodding

	y-axis 
	Front to back
	Tilting

	z-axis
	Up and down
	Shaking




To facilitate alignment, BrainVoyager provides a number of ways to display the functional data. The first option is to switch between target (anatomical) and transformed (functional data) - by checking the Show transformed or Show target options under Target display options – alternatively the F5 key will toggle between these two options. 

BrainVoyager can also overlay the functional data directly over the anatomical in a number of ways. By checking the Blend: Transparent option BrainVoyager will overlay the functional data semi-transparently over the anatomical. The degree of transparency can be changed by either clicking on the Options button and changing Blend mode transparency or by clicking in the transformation window and then using Ctrl and the Up and Down arrows. Transparent blending is useful for quickly aligning the functional data so that is is close to the anatomical but not as useful for refining the alignment.

By checking Blend:Mosaic option BrainVoyager will display the data as if on a checkerboard with alternate squares of functional and anatomical data. This can be useful for checking and adjusting sulcus alignment.

By checking Blend:Edges, BrainVoyager will display edge contours which have been detected in the functional data. The edge detection thresholds can be changed in the Options dialog and the degree of transparency of the contours can be changed as with transparent blending.

Take care when transforming the functional data that you check alignment in all slices as it is possible to have perfect alignment within a slice whilst the rest of the slices do not align at all.

Once you have manipulated the functional data to achieve the best alignment to save the alignment transformation

· On 3D Volume Tools on the Coregistration tab click Align… under FMR-VMR Coregistration
· On the Fine-Tuning Alignment tab click Manual aligment – use current translation and rotation values
· Click Run FA
· Click Close

At this point BrainVoyager will have created two new files in the folder containing the functional data. The files will have the extension trf and a suffix of _IA for initial alignment and _FA for Fine-Tuning alignment.

[bookmark: _Toc366483410]Creation of the VTC

Having aligned the functional data to the anatomical, the functional data can now be converted from slices in the FMR into 3D volumes in Talairach space (VTC).

To create the VTC

· Load the non-Talairach anatomical if not already loaded
· On the Analysis menu choose Create 3D-Aligned Time Course (VTC) Data …
· For Functional slice based data file (FMR), choose the FMR file which you have just aligned to the anatomical
· For FMR-VMR coregistration file 1: i.e. header-based (_IA.TRF): select the _IA.trf from the same folder. 
· For FMR-VMR coregistration file 2: i.e. intensity based fine tuning (_FA.TRF): select the _FA.trf from the same folder.
· For AC-PC translation/rotation file - Talairach step 1 (_ACPC.TRF): select the file _ACPC.trf from 3D folder which was generated  as part of the Talairach transformation of the anatomical data.
· For Cerebrum border file for scaling - Talairach step 2 (.TAL): select the file _TAL.tal from 3D folder which was generated as part of the Talairach transformation.
· Click the Options button and select the target resolution. For 2.5x2.5mm voxels choose 3x3x3 and for higher resolution select the highest resolution greater than or equal to the resolution at which the functional data was scanned.
· Depending on the purpose of the VTC select either Nearest neighbor or Trilinear interpolation – see Matthew or Zoe about what is the most appropriate interpolation – for localizers select trilinear.
· Click OK
· Click GO

BrainVoyager will now generate the VTC file in Talairach space.


To check the aligment of the VTC data with the Talairach anatomical

· Load the Talairach anatomical  suffixed_final_TAL.vmr
· On the Analysis menu choose Link 3D Time Course (VTC) File …
· Select the VTC file which you have just created from the target folder
· Check Store reference to VTC file
· Click OK
· On 3D Volume Tools click the Spatial Transf tab
· Click Show VTC Vol

· BrainVoyager will display a representation of the 1st volume of the VTC in volume space.
· On the File menu choose Save Secondary VMR …
· Save the VMR into the functional data folder with the name suffix _vtc.VMR
· Close the final_TAL.vmr file
· Re-open final_TAL.vmr
· Click the Coregistration tab on 3D Volume Tools
· Under VMR-VMR coregistration click Select VMR and  select the VMR file _vtc.vmr which you have just saved.

Use the F5 key to toggle between the TAL.vmr and the vtc.vmr to check the alignment. If the alignment is correct there should be virtually no movement between the anatomical and functional data – in particular check the Ventricles and if in doubt refer to other people in lab.

If the vtc.vmr is not well aligned well to the TAL.vmr, then you will need to go back and do the coregistration.
[bookmark: _Toc366483411]Batch creation of VTCs

If you are satisfied with the alignment of the functional scan to the anatomical then you can batch process the remaining functional scans in the session using the same alignment parameters.

From the Plugins menu select CNIL Processing Functions and choose Create VTC Files.

BrainVoyager will ask you to select the session folder and the reference FMR which should the FMR which you aligned manually. BrainVoyager will use the format of the file name of the reference FMR to determine which other FMR files are eligible.

BrainVoyager will then present the following dialog
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For each required file on the left hand side, click on the … button to locate the file. The IA and FA files will be found in the functional data folder and the TAL,VMR and ACPC files will be found in the anatomical.

Once you have provided all the required files, set the VTC resolution and interpolation method. These should be decided based on the nature of the experiment As a general rule you should choose the resolution closest to but no higher than the resolution of your functional scans.

For standard resolution localizers select a VTC resolution of 3mm and for high resolution localizers select a VTC resolution of 2mm. 

For all localizers set the interpolation method to trilinear. If you are intending to use multivariate classifiers in your analysis use nearest-neighbour interpolation.

Ensure that you have checked the files from which you wish to create VTC’s, by default the file which you processed manually will be unchecked, if you check it then the existing VTC file will be overwritten.

Click OK and BrainVoyager will create VTC files for all the files selected.

If you have also created smoothed FMR’s for GLM then remember to make sure to created VTC’s from both the smoothed and unsmoothed data files.

To check the alignment of the automatically created VTCs

· Load the Talairach anatomical  suffixed_final_TAL.vmr
· On the Analysis menu choose Link 3D Time Course (VTC) File …
· Select the VTC file which you have just created from the target folder
· Check Store reference to VTC file
· Click OK
· On 3D Volume Tools click the Spatial Transf tab
· Click Show VTC Vol

· BrainVoyager will display a representation of the 1st volume of the VTC in volume space.
· On the File menu choose Save Secondary VMR …
· Save the VMR into the functional data folder with the name suffix _vtc.VMR
· Close the final_TAL.vmr file

Check the alignment of the automatically created VTC with the anatomical as you did for the manually aligned VTC.

Check the alignment of the automatically created VTC with the manually created VTC 

· Loading the vtc.vmr for the manually created VTC
· Click the Coregistration tab on 3D Volume Tools
· Under VMR-VMR coregistration click Select VMR and  select the VMR file _vtc.vmr which you have just created for the automatically created VTC.

Use F5 to toggle between the vtc.vmr for the automatically created VTC and the manually created VTC.  If the alignment is correct there should be virtually no movement between the anatomical and functional data – in particular check the Ventricles and if in doubt refer to other people in lab.

If the alignment is not good then you can correct and the alignment manually and re-run the VTC creation manually as described above. 

Check each automatically created VTC to ensure that the optimum alignment is achieved across all functional scans and the anatomical.
[bookmark: _Toc366483412]Cross session alignment and VTC creation

To perform cross session alignment and VTC creation

· Process the PAR/REC files and pre-process the FMR files for the second session in the normal way
· Align the first FMR scan from the second session to the anatomical from the first session as detailed above.
· Create the VTC for the first scan in the second session.
· Check the alignment of the first scan from the second session with the anatomical from the first session and with the first functional scan from the first session.

If the alignment is very good, then create VTC’s for the rest of the functional scans in the second session as detailed above.

If the alignment is not good, 

· Adjust the x, y, z values so that the two functional scans between sessions are well aligned to each other. 
· Write down the values from the Coregistration tab for this – the adjustment should be quite small.
· Load the non-Talairach final VMR
· Under FMR-VMR Coregistration Sselect the FMR file from the second session which is not well aligned.
· Click the Spatial Transf tab 
· Click Load TRF and select the IA.trf from the second session
· Click Load TRF and select FA.trf from the same folder
· From  the Coregistration tab write down the Translation and Rotation values
· Add the adjustments which you wrote down first to the translation and rotation values on the Coregistration tab
· Enter these new values back into the Coregistration tab
· Click Align… in FMR-VMR coregistration
· On the Fine-Tuning Alignment tab check Manual alignment - use current translation and rotation values. 
· Click Run FA to save the transformation
· Close final.vmr and re-run the VTC creation
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Check the alignment again and repeat the process until optimum alignment is achieved. 

It is possible you might have to do this 3 or 4 times particularly if you are comparing scans at different resolutions. Each time check the alignment against the anatomical and the reference functional from the first session.
Once you have aligned the first scan from the second session satisfactorily, repeat the batch process for aligning subsequent scans – check the alignment for each scan with the anatomical and functional scans from the first session. If the alignment for a scan is not good then you will need to repeat the alignment manually.

The ultimate goal is to end up with all the functional scans aligned optimally to each other and also to a reference anatomical. If any scan is poorly aligned then the resulting statistical analysis will not be accurate.
[bookmark: _Toc366483413]Verification of Functional Brain Coverage

When running group analyses, the resulting statistical maps might cover less brain space than one might expect. The reason is that BrainVoyager only calculates statistical values for those voxels that have valid functional data at a given voxel across all included data sets.

In order to verify regions containing functional data across multiple VTC files 

· Load the final_TAL.VMR 
· Select Verify Functional Coverage from the Options menu.
· For each VTC to verify the coverage click the + button and choose the appropriate VTC file
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Click the GO button and BrainVoyager will calculate the degree of coverage across all VTC’s and display a statistical map illustrating the coverage across all runs. The scale corresponds to the percentage of runs in which a given voxel represents functional data.
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[bookmark: _Toc366483414]Analyzing Functional Data
[bookmark: _Toc366483415]Defining regions of interest (ROI)

The first step in functional data analysis is to create a statistical map, showing which regions of the brain have been activated above some particular threshold. 

In order to make sense of such an activation map it is beneficial to identify certain specific areas which are known to be sensitive to specific stimuli. By presenting such stimuli to the subject and analyzing the resulting statistical map it is possible to “localize” these particular areas. This is particularly important in mapping regions such as the visual cortex and other areas associated with visual processing. The areas which are identified as corresponding to specific stimuli are called regions of interest. A scan which is designed to identify regions of interest from known stimuli is called a localizer scan or just a localizer.

The main localizers which are covered in this document are as follows

· Polar or POL – this is used to map the visual cortex
· LOC or Lateral Occipital Complex - the region LO is known to be activated preferentially by intact objects or shapes as opposed to stimuli which do not represent a whole object . There are three separate areas in LOC – LO, pFs and CoS.
· MT+ or Middle Temporal – the region MT+ is known to be activated preferentially by stimuli which are in motion.
· KO  or Kinetic Occipital – the region KO is known to be activated preferentially by  edges created by contrasting motion – known as kinetic boundaries.

A localizer scan is designed to present contrasting stimuli to a subject, one of which is known to preferentially activate the specific areas which are sensitive to that stimulus. For example in the case of LO the stimuli consist of intact objects (both real and abstract) and scrambled representations of the same object.

Within the lab two different types of regions of interest analysis are used. The first is called Retinotopic Mapping and is used to identify and delineate different regions of the visual cortex – retinotopic mapping will be used to identify areas highlighted with the Polar localizer. The second is the use of the General Linear Model which is used to identify other important regions of the brain which are associated with cognitive function – LO,KO and MT localizers are all analysed in this way.

This section will detail the principles behind both methods.

[bookmark: _Toc366483416]Folder Preparation

Before analyzing localizer data some additional folders should be created.

In the top level of the scan folder 

· Create a folder named ROI_vtc
· Create a folder named Voi_files
· In the ROI_vtc folder create a further 6 folders as follows
· vmp
· smp
· sdm
· prt
· vtc
· glm


[bookmark: _Toc366483417]Protocol and RTC Files

In order to analyse functional MRI data it is necessary for BrainVoyager to know what stimuli were presented to the subject at any given point during the scan. 

The sequence of stimuli is known as the protocol for the scan and is contained in a file with the extension PRT. For each localizer which is run in the lab, a protocol file will already exist. These localizer protocols along with a number of other supporting files are contained on Common in the Brainvoyager Localiser Protocols folder. Prior to analyzing localizer data, copy these files to the prt folder under the ROT_vtc folder which you just created.

[bookmark: _Toc366483418]Retinotopic Mapping

To identify the regions of the visual cortex, BrainVoyager uses a process called Retinotopic Mapping. This relies on the fact that there is a topographic relationship between a position in the visual field and a point in the primary visual cortex. In the cortex, neighbouring positions in the visual field are represented by groups of neurons adjacent but laterally displaced within the cortex. Mapping between the retina and the cortex can be best described as a log-polar transformation such that standard axes on the retina are transformed to polar axes in the cortex – eccentrcitiy being the distance from the fovea and the polar angle the distance from the horizontal axis. The logarithmic component accounts for the fact there is a more cortical tissue devoted to foveal regions than peripheral which gives rise to a magnification effect at the centre of the visual field

By exploiting this topographical relationship, it is therefore possible by stimulating certain positions on the retina to expect the brain to be activated in specific areas accordingly. This occurs not only in V1 but other early visual areas V2, V3 and V4 etc. with an alternating direct or mirror representation of the visual field.
 
By manipulating the position at which the retina is stimulated at any given time and observing which areas of the brain respond accordingly at a given time after stimulation a map of the visual areas can be produced.

To achieve this in BrainVoyager we use a stimulus which stimulates only certain areas of retina at any one time – this consists of either a rotating wedge which identifies the boundaries or vertical meridians between the visual areas  (known as a polar localizer or POL) or a moving ring centered on the middle of the display which identifies the horizontal meridians around the occipital pole, this is  known as the eccentricity localizer or ECC and can be used to identify central versus peripheral visual field. These kinds of stimuli are termed phase-encoded because stimulation of the visual field is as the visual field is stimulated repeatedly, the response to a specific eccentricity or polar angle corresponds to the phase within a cycle.

In order to map the visual field to corresponding regions in the visual cortex BrainVoyager uses a method called cross-correlation analysis whereby the time point at which a specific region will respond maximally to a stimulus can be calculated. This is known as the lag.

To perform cross correlation analysis we define a reference time course of activation which provides a model of the activation expected for the first position of the stimulus. By shifting this reference time course for each subsequent position we can also calculate correlation values for each subsequent change in position of the stimulus. The number of shifts in position is known as the number of lags.

By plotting the lag at which maximal correlation to the reference time course was obtained and by colouring each lag differently we can get a map of the visual cortex such that each change in colour corresponds to a change in position and hence different visual areas.

To perform retinotopic mapping in BrainVoyager we first have to link the protocol for the retinotopic mapping stimulus to the VTC file.

· Load _final_TAL.vmr
· Link the VTC for the localizer POL  to the VMR
· On the File menu choose VTC properties
· For the Linked protocol file select the file RetMapping_new.prt in the ROI_vtc\prt folder
· Click Save to permanently save a reference to the protocol with the VTC

We then calculate linear correlation maps for each hemisphere separately

· From the Analysis menu choose Compute Linear Correlation Maps…

BrainVoyager will show the protocol for the stimulus as coloured bars – the x-axis shows the time course in volumes
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· Click Load RTC and load the file Pol_lh_hdf.rtc from the ROI_vtc\prt folder to display the reference time course for retinotopic mapping
· Check Enable under Cross correlation and set the number of  lags to 14 – this is specific to the retinotopic mapping protocols which are used
· Click the GO button

BrainVoyager will now perform cross-correlation analysis and display the results overlaid on the anatomical – the colours correspond to the lags at which maximum correlation to the reference time course was achieved.

To properly visualize the visual cortex the colors for each lag value need to be changed

To change the colour mapping for the retinotopic map 

· On the Options menu choose Statistical Map Look-up-Table
· Click Load OLT and load the file blue_green_yellow_red.olt from the ROI_vtc\prt folder
· Click Apply now
· Click OK

The colour mapping for lag values should now be reversed

To save the results of the retinotopic mapping we create a file called a Volume Map or VMP – this file can be loaded over an anatomical to display the activation without having to rerun the statistical analysis.

To save the VMP

· From the Analysis menu select Overlay Maps …
· Click on the Save VMP button and save the VMP as pol_lh.vmp in the ROI_vtc\vmp folder

To display the activation from the retinotopic mapping on the inflated mesh

· From the-Meshes menu choose Load Mesh …
· Load the LH_inflated.srf from the 3D folder
· From the Meshes menu choose Mesh Morphing …
· Ensure that the Use information from file is set to use the LH_RECOSM mesh and set it if not
· Click Quit
· On the Meshes menu choose Surface Maps …
· Click the Create SMP button

BrainVoyager will overlay the results of the cross correlation analysis on the inflated mesh – however by default BrainVoyager will show correlation values and we need to visualize lag values.

To visualize lag values

· On the Browse tab Click <CROSS CORRELATION> to select the correct map
· On the Statistics tab check Lag Values – the number of lags should be 0-13

You can adjust the threshold of the map by clicking on the decrease or increase threshold buttons on the left toolbar – 4 and 5 buttons from the bottom. This will change the lower threshold for the correlation value at which the lag will be displayed. You can also change this in the Surface Maps dialog by changing the Min value for MaxCrossCorr range on the Statistics tab.

You can save the results as a surface map or SMP which will allow you to overlay the results on a mesh without re-running the analysis.

· To save the surface map
· On the Meshes menu choose Surface Maps
· Click Save SMP and save the file as pol_lh in the smp folder under ROI_vtc.

Finally save a new mesh with the activation from the retinotopic mapping overlaid on it

· On the meshes menu choose Save Mesh
· Save the mesh with the suffix LH_inflated_Ret.srf in the 3D folder.
· Close the Mesh and VMR

To load the surface map on the mesh without re-running the analysis

· Load final_TAL.vmr
· Link the POL VTC file
· Load the LH_inflated.srf  mesh
· From the Meshes menu choose Surface Maps
· Click Load SMP and load the file pol_lh.smp from the ROI_vtc\smp folder

Don’t forget to repeat the cross-correlation analysis on the right hemisphere – use the Pol_rh_hdf.rtc file for the reference time course.
[bookmark: _Toc366483419]Defining the areas of the Visual Cortex

Having performed cross-correlation analysis, by examining the overlaid brain activation maps we can use the colours for each lag position to identify different areas of the visual cortex.

From the retinotopic map, the boundaries of the early visual areas can be identified where there are colour changes – representing different lag values – i.e. different times at which maximal correlation with the reference time course occurs.

The colour changes for the early visual areas for a polar scan are shown below. By identifying the corresponding bands of colour we can demarcate the respective visual areas. For example in the left hemisphere, V1 is demarcated by a band of red dorsally (top surface) and a band of blue ventrally (bottom surface).

Using BrainVoyager we can create regions of interest (ROIs) which identify the voxels associated with each area.
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To identify regions of interest for the visual cortex

· Hold down the right mouse button on the mesh until a menu appears. 
· Select Save Colors for Undo – this will create a temporary snapshot of the mesh which can be restored by holding the right mouse button down and selecting Undo: Restore Mesh Colors which can be very useful if you make a mistake in identifying a region of interest.
· From the Meshes menu select Painting and Cutting
· Under Mesh drawing and filling check Deletion mode
· To enter line drawing mode select the Draw/Cut Mesh Mode button on the right toolbar – 3rd from the bottom.
· Hold down the Shift key and the Alt key and click once on the mesh with the left mouse button
· With the Shift and Alt keys kept down click again on the mesh, BrainVoyager will draw a red line between the first and second points – the line will not be completely straight as BrainVoyager is drawing the line based on the voxel representation of the mesh.
· Take care not to click twice in the same place as BrainVoyager will not be able to determine where the line should go to and will create a blob instead.
· To start a new line in a different place release the Shift key and the Alt key and click the mesh where you want to start the new line. Without moving the mouse hold the Shift and Alt keys down again and click in the same place to start a new line. Keep the Shift and Alt keys down and click again on the mesh, a line will be drawn from the new starting point to the point where you clicked the mouse.

To demarcate area V1 

· Draw lines along the middle of the red band above the Occipital point
· Hold the right mouse button down and click Save Colors for Undo to save the line
· Release the Shift and Alt keys and click on the mesh at the top of the blue band below the Occipital point.
· Draw lines along the middle of the blue band below the Occiptal point
· Hold the right mouse button down and click Save Colors for Undo to save the line

Having drawn the lines demarcating V1, using the colour change diagram above, draw in the lines for the rest of the areas. 

Finally join up the edges of each area to each other. You should end up with a set of roughly parallel areas around the occipital pole as shown in the illustration below.
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Once you have outlined all the retinotopic areas save the mesh with the suffix 
LH_inflated_Ret_activation.srf

[bookmark: _Toc366483420]Labeling the regions

To remove the activation map 

· On the Meshes menu choose Background and Curvature
· Check the option Use two colors for convex and concave and click the Curvature button
· The activation on the mesh will be removed but the boundaries of the retinotopic areas will remain
· Save the mesh with the suffix LH_inflated_Ret.srf – this will overwrite a mesh which you created earlier.

To colour the regions

· On the Meshes menu select Painting and Cutting
· Make sure Painting mode is selected
· Each of the regions needs to be painted in a different colour
· Set the Color Index to 1
· Select the Fill Mode button on the right hand toolbar – 2nd from bottom
· Click with the left mouse button inside the region identified as V1 – the region will be filled in a blue colour
· Set the Color Index to 2
· Select the Fill Mode button and click in the region identified as V2 dorsal

Repeat the process until all the regions are filled in with different colours as follows

	Region
	Color Index

	V1
	1

	V2d
	2

	V3
	3

	V3a
	4

	V2v
	5

	VP
	6

	V4v
	7

	V7
	8




Once all the regions have been correctly coloured then they can be labelled

To label the regions

· Hold the right mouse button down on the mesh and select Define Patch-Of-Interest (POI)
· In the dialog set the Paint index to 1 and set the name to V1_lh
· Check the option Create corresponding VOI
· Make sure the option Clear paint color is unchecked
· Click OK
· Repeat for each of the other defined regions using the Color indices defined above – name each region as above suffixed with _lh for left hemisphere

To save the region of interest file

· On the Meshes menu choose Patch-Of-Interest Analysis
· Ensure all the regions have been defined and named
· Click the Save button and save the file as  ret_lh.poi in the voi_files folder
· Click on the Options button
· On the POI Functions tab for POIs to VOIs click on the Create button
· Click on the VMR tab if it is not already selected to display the anatomical
· On the Analysis menu click on Region-Of-Interest Analysis
· Check that the Volumes-Of-Interest list shows all the regions which you have defined
· Click on the Save button and save the file as ret_lh.voi in the voi_files folder

Repeat the process for the right hemisphere – save the results as ret_rh.poi and ret_rh.voi.

After having done both hemispheres – you can combine the voi’s for the left and right hemispheres together.

· On the Analysis menu choose Region-Of-Interest Analysis …
· If not already loaded load the ret_lh.voi file
· Click on the Add button and load the ret_rh.voi file
· In the dialog hold down Ctrl and click on v1_lh and v1_rh – both items should be highlighted
· Click a OR b – this will create a new region which is the union of V1 in both the left and right hemispheres
· Name the region V1_all
· Repeat for the other regions
· Save the resulting file including the _lh, _rh and _all VOIS as ret_all.voi in the voi_files folder


[bookmark: _Toc366483421]Retinotopic mapping for eccentricity

For eccentricity mapping, follow the same procedure as for polar mapping except the number of lags for the cross-correlation analysis should be set to 32. Save the VMP files as Ecc_lh.vmp and Ecc_rh.vmp.

Create a surface map and save the mesh with the suffix _Ret_Ecc_Activation. Do this for both hemispheres.
The boundary between the central and peripheral visual fields are blue and yellow so draw a line between these two colours.
Create a VOI identifying the central field – central_lh and peripheral periph_lh
You can also create VOIs identifying central vs peripheral for each visual area – e.g. V1_central_lh etc.

[bookmark: _Toc366483422]Statistical analysis using the General Linear Model

Neuronal activity associated with cognitive processes changes with both space and time. Spatial resolution refers to the ability to distinguish changes in activity across different spatial locations, while temporal resolution describes the ability to distinguish between changes in activity at a single location over time.

When scanning using fMRI, the brain is considered to be divided up into 3D rectangular prisms called voxels; whose dimensions determine the spatial resolution of a scan- the smaller the voxel then the higher the resolution of the scan.

In addition the aim of fMRI is to examine the change in activity of the brain over time in response to an experimental manipulation. fMRI data is therefore collected as a time series whereby the brain is scanned at discrete intervals over time.

A single fMRI scan is termed a run and within a single run the time series is divided up into individual scans known as volumes.

In order to perform meaningful statistical analysis of fMRI data it is necessary to consider both the spatial component and the temporal component of the data. That is , the spatial component identifies where in the brain activity is taking place and the temporal component identifies how it changes over time. Thus the data for a given run can be considered as a measure of activation per voxel which changes over time.

The challenge in the statistical analysis of fMRI is therefore determining whether the level of activation in a given voxel over time is significantly affected by the experimental manipulation or stimulus which is presented during the run.

A powerful technique for analyzing fMRI data is the use of the General Linear Model.

The General Linear Model or GLM considers the overall activation of a given voxel over time to be a linear sum of the factors which contribute to the activation – this is essentially an extension of the equation of a straight line.

The equation of a straight line considers the values on the y axis (the measured value) to be directly related to the values on the x axis – the stimulus value by the following equation


 

Where y is the measured value, x is the stimulus value, m is the slope of the line and c is the offset on the y axis where x=0.

The GLM can be represented as an extension of this






Here the activation of a given voxel represented by y in the equation is explained by the terms on the right hand side of the equation. The parameters are considered to be the factors which are affecting the overall activation in a voxel whilst the parameters are the scale factors or weightings of the contributions of each factor to the overall activation.

If the value of y can be completely explained by the factors which are represented by the different values of x then provided the values of x and the weights m are known then the overall activation y can be exactly predicted. If this is not the case then there is an unknown contribution from factors which have not been included – this is the error in the equation and is represented by the parameter c.

The purpose of the GLM is to manipulate the weightings for each known factor which contributes to the activity (called a predictor) such that the value of c is minimized.

The more relevant predictors which are included in the equation, the more accurate the prediction of the activation can be and the lower the error. Of course introducing irrelevant predictors will have a negligible affect on the result.

In a typical fMRI experiment we are interested in how a variation in a particular stimulus can affect the overall activity in a given voxel – this is known as a condition of the experiment.

By considering each condition of an experiment as a predictor for the overall activity we can consider how relevant (or significant) the contribution of a given condition is in the overall activation pattern which is observed.

From the results of the General Linear Model we will get an estimate of the contribution of each condition to the overall activation on a per voxel basis and by thresholding these estimates using a statistical significance test we can identify which  voxels are significantly affected by the presence of a specific condition. The usual significance test which is applied is a t-test.

As with the retinotopic mapping, a crucial aspect of the GLM is that we known at any given time point in a run what stimulus was being presented to the subject. We therefore make use of the same idea of a protocol to describe the change in condition over time.

To prepare to analyse a single run of data using the GLM

· Load the final_TAL anatomical file into BrainVoyager
· Link the relevant run VTC file to the anatomical
· On the File menu choose VTC properties and link the appropriate protocol file to the VTC

The protocol file for all the localizers which you will run is defined for you and can be found in the ROI_vtc\prt folder – these are as follows

	Localizer
	Protocol

	LO
	LOLoc.prt

	MT
	MTDotLoc.prt

	KO
	KOLoc.prt



· Click the Save button to permanently associate the VTC file with the correct protocol file

To perform the GLM on a single run 

· On the Analysis menu choose General Linear Model: Single Study

If you have correctly linked the VTC and PRT files then you will see a dialog like this (for LO)

[image: ]

The coloured bars represent the different conditions which were presented to the subject over time. In the case of LO the conditions are called Fix, Scr and Int. Where the coloured bar is green, a scrambled stimulus was presented and where the coloured bar was blue an intact stimulus was presented. When the bar is grey there is no stimulus and only a dot or cross is presented for the subject to fixate on to maintain their attention.

The white line in the plot represents the overall predicted activation for a given condition. Since we have not yet defined any predictors the activation over the whole time course will currently be 0 as shown in the figure above.

The other localizers all show the same kind of plot with different colours and ordering of stimulus over time.

In order to construct the GLM we first need to compute the predictors for each condition.

Since we are not interested in the contribution of the fixation condition we can exclude it (this is also necessary statistically otherwise the model will be what is known as overdetermined) By convention the fixation condition is normally defined as either the first or last condition in the protocol (note this does not mean that the fixation will always be presented first or last chronologically however it is normal to present a fixation at the beginning and end of a run to allow the subject to fixate properly before presenting a stimulus.

To exclude the fixation condition from the model

· In the Single Study General Linear Model dialog click on the Options button
· Ensure the option Exclude first condition (“Rest”) is checked and that the check box Dummy coding is also checked.

There is a final step which we need to do before we can define the predictors for the conditions in the experiment. This can be illustrated as follows

· In the Options dialog uncheck the option Apply HRF and choose OK
· Click on the Define Preds button in the Single Study General Linear Model dialog

This will define a predictor for each of the conditions (excluding fixation).

[image: ]

For each predictor BrainVoyager has generated an activation trace (the white line) which would show what the predicted activity in a given voxel would be if the entire activity in the voxel could be completely accounted for by the presence of that condition and in the absence of that condition no activity could be observed. In the image above, the activity when  a scrambled object is presented is shown as 1.0 (i.e. the voxel is 100% activated) and when an intacted object (or fixation) is presented then the activity is 0.

To show the activity for the intact condition click the up spin button for predictors, this will show that for the intact condition the opposite will be true.

There is however a problem with this as a predictor for fMRI activity and this is due to the nature of the fMRI signal itself.

Neurons in the brain are activated electrically, this is a process which can take place almost instantaneously and if we were to be measuring directly the electrical activity of the brain then the predictors which were defined above would be good approximations.

However the fMRI technique measures a different effect in the brain known as the BOLD response – this stands for the Blood Oxygen Level Dependent response. The BOLD response is based on the hypothesis that a high level of brain activity requires more energy than a low level – to supply this increase in energy there is a corresponding increase in blood flow in the active areas as energy releasing molecules are contained in the blood. fMRI can be used to detect this increase in blood flow by the fact that different levels of oxygenated and deoxygenated haemoglobin in the blood give rise to a distortion of the magnetic field which can be detected in an fMRI scanner.

Crucially however the change in blood oxygenation is a much slower process than the electrical activity in the brain so the overall increase in activity in response to a given stimulus is much more gradual.

The change in blood oxygenation due to the BOLD response can be modeled mathematically by a function know as the Haemodynamic Response function or HRF. By taking the instantaneous activity predictor defined above and modulating it, by a process known as convolution, with the HRF we can create a good approximation of a predictor of the BOLD response in the presence of a stimulus.

BrainVoyager allows us to create BOLD predictors for the GLM as follows

· In the Single Study General Linear Model dialog click on the Options button
· Make sure this time that the Apply HRF checkbox is checked
· Click Define Predictors

This time the predictor will be define as follows
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Here you can clearly see that the increase in activity is not instantaneous but rises and falls gradually as the stimulus changes. You might also see that the activity actually falls below 0 at certain points – this is due to the nature of the HRF and is an accurate effect of the BOLD response itself.

Also the effect of the HRF with just to predictors is quite obvious however when there are multiple conditions the effect of the HRF can produce quite complex predictor patterns.

Improving the model

As explained above, the better the model for the GLM the more accurate the results. One of the most important factors with regards to the model is reducing the degree of noise and one of the key causes of noise is subject motion in the scanner. 

As part of the FMR pre-processing step we corrected for subject motion in the functional data. As part of this process, BrainVoyager saved a record of the changes in position over time. By using this record we can apply extra predictors to the model which can be used to reduce the noise due to motion.

To correct the model for subject motion

· On the Single Study General Linear Model dialog click the Add button
· In the folder which contains the VTC data you are trying to analyse select the file with the suffix SCCA_3DMC.SDM which was generated as part of the FMR pre-processing

BrainVoyager will add additional predictors for each degree of motion – you can view these predictors by changing the predictor spin button – the name of the predictor corresponds to the type of motion represented.

Save the predictors including the motion correction to a new file – you can use this file next time you run the the Single Study GLM and you will need this file if you want to run a GLM across multiple runs.

To save the predictors as a Single Study Design Matrix (SDM)

· Click on the Save button
· Save the file as LO.sdm, KO.sdm or MT.sdm depending on the localizer in the roi_VTC\sdm folder

Running the GLM

Having defined the predictors and refined the model, click the GO button in the Single Study General Linear model dialog. BrainVoyager will then display the output with the activation overlaid on the anatomical.

Displaying the correct contrast

By default the activation which is displayed as a result of the GLM shows areas which are significantly activated by all conditions. However for localizer mapping, what we want to display is the areas which are preferentially activated by one condition as opposed with another. To do this we need to change the contrast of the GLM.

To change the contrast of the GLM

· On the Analysis menu choose Overlay General Linear Model

BrainVoyager will display a list of predictors. By default all the predictors will have a + sign next to them showing that the result shows areas which are strongly activated in all conditions. (BrainVoyager automatically excludes predictors generated from motion correction).

For localizer mapping, the conditions are set up so that second predictor should be more strongly activated than the first.

· Click on the + sign on the first predictor, it will change to a – sign. This shows that the contrast we want is such that activity for the second condition is greater than the first. 

If you click on the – sign again, the sign will disappear, this can be used to exclude the predictor from the contrast altogether, however in the case the result we want is for the first condition to have – and the second to have +.

· Click on the Balance +/- button. This ensures that the contribution from each condition is equal – in the case where there are an equal number of predictors with + and – this does not make a difference, however if you want to examine the effects of multiple predictors then clicking this button ensures that the GLM contrast is balanced.

· Click on the Save GLM button and save the GLM definition in the roi_VTC\GLM folder as LO.GLM, KO.GLM, or MT.GLM depending on the localizer you are analyzing.
· Likewise, click on the Save CTR and save the GLM contrast 
· Click the OK button.

BrainVoyager will now change the output to show areas which are activate differently between the first and second predictors. Areas in orange colours are activated more strongly by the second predictor, whilst those in blue are activate more strongly by the first. Since we are only interested in areas more strongly activated by the second predictor we can eliminate the negatively activate areas as follows.

· On the Analysis menu choose Overlay Volume Maps
· On the Browse tab under Overlay values uncheck Negative, BrainVoyager will only show areas were which were positively activated for the second condition.

The activation map is likely to show activation in multiple areas of the brain – some areas being more strongly activate than others.

You can change the lower threshold of significance for activation either in the Overlay Volume Maps dialog on the Statistics tab under Confidence range or by using the Increase/Decrease threshold buttons on the left hand toolbar.  However it is only possible to set the upper threshold in the Overlay Volume Maps dialog.

It is also possible to remove noise in the map by enabling the Cluster threshold option – by changing the threshold number of voxels you can eliminate areas of activation which are less than the threshold number of voxels in size.

Adjust the threshold so that strongly activated areas are clearly represented. The probability of voxel activation being not due to the stimulus is displayed below the colour range bar on the right of the window, don’t let the p value  go above 0.01 as this will start to activate areas erroneously.

Once you are happy with the display, save the VMP from the Overlay Volume Maps in the following form XX_GLM_#.##.VMP where XX corresponds to the localizer name and #.## is the lower threshold value displayed on the map. Save the file in the ROI_vtc\VMP folder.

To display activation on the inflated mesh

(Assuming you have mapped the visual cortex using retinotopic mapping as described previously.)

· Load the mesh with the suffix _inflated_RET
· On the meshes menu choose Surface Maps
· On the Advanced tab click Options
· Under additional options check Sample maximum value – because the cortex is more than one voxel thick, it is possible to have a higher level of activation on a voxel which is not on the surface of the cortex. Checking this option ensures that the highest activated voxel is represented on the mesh.
· Click OK
· Click Create SMP

BrainVoyager will now display the activation map for the localizer on the mesh using the same threshold as you specified for the volume view.

· On the Browse tab uncheck Negative for Overlay values so we exclude negatively activated voxels.
· On the Statistics tab ensure the Use statistic value option is checked
· Save the SMP file, using the same naming convention as for the volume map, in the ROI_vtc\SMP folder.

[bookmark: _Toc366483423]Mapping regions of interest from the GLM

Having described the general process for computing the GLM and overlaying the results from the contrast onto the anatomical and mesh we can now identify the localizer regions of interest.

Before continuing please ensure that you have created surface maps for each of the localizers which you wish to identify, LO,KO and MT all have areas which lie very close to each other and the visual cortex and it will be necessary to overlay maps for each area to determine the area boundaries.

The exact location and shape of each region of interest can vary considerably from subject to subject so a certain amount of subjectivity is involved in determining where a particular region lies.

To aid in the identification of each region we can use the fact that we have transformed the functional data we are working on into Talairach space.

We can use the fact that Talairach coordinates for a large number of areas of the brain have been reported widely in the literature. For reference, there is  a detailed list of Talairach coordinates for many different areas of the brain later in this document.

For convenience here are the reported Talairach coordinates for LOC,KO and MT

LOC is actually is subdivided into three separate regions, LO, pFs and CoS – each areas is reported below.

	
	Left Hemisphere
	
	Right Hemisphere

	Region
	x
	y
	z
	
	x
	y
	z

	LO
	-44 ± 9
	-67 ± 12
	-3 ± 4
	
	42 ± 3
	-67 ± 7
	-4 ±7

	pFs
	-41 ± 8
	-46 ± 11
	-20 ± 3
	
	46 ± 7
	-48 ± 6
	-22 ± 5

	CoS
	-31 ± 3
	-46 ± 12
	-10 ± 4
	
	29 ± 6
	-43 ± 9
	-15 ± 10

	KO
	-34 ± 5
	-73 ± 6
	7 ± 3
	
	37 ± 7
	-70 ± 6
	8 ± 7

	MT
	-43 ± 3
	-66 ± 6
	0 ± 5
	
	44 ± 3
	-64 ± 4
	-2 ± 3



To identify the location of a functional area

· Close all open windows
· Load the final_TAL.VMR for the subject
· Load the volume map for the localizer of interest
· Load the inflated mesh
· Load the surface map for the localizer of interest
· Click on the mesh view
· On the right hand toolbar select the Vertex Mode button (the white button third from the bottom)

You can check the Talairach coordinates for a particular region by clicking in the mesh, the Talairach coordinates for the selected point will be displayed in the status bar.

Having found the correct area from the Talairach coordinates you can draw on the mesh to highlight the region in the same way as you did when mapping the visual cortex.

Once you have identified the relevant areas use the table below to colour the areas. 

	Area
	Colour 
	Colour Index

	MT
		Metallic Blue
	9	

	KO
		Purple
	7

	LO
		Yellow
	3

	pFs
		 Red
	6

	CoS
		 Pink
	4



Additional localisers which you might also use should be coloured as follows

	Area
	Colour 
	Colour Index

	MTplus
		Blue
	1	

	MST
		Green
	5



[bookmark: _Toc366483424]Verification of functional data

In order to ensure that functional data does not contain unwanted artifacts (particularly at the beginning of a scan) we can analyse the time course of the data using a small Matlab script which can be found at  \\psg-zk-srv1\Common\Software and Scripts\BVQX Processing Scripts\BVQX Matlab Scripts\VOI Time Course

The script will analyse the first 40 volumes of the time course and produce a plot of the timecourse averaged over each VOI. 

To run the script
Copy the file plotVTCData.m from the folder referenced above to an appropriate place on your PC

Open Matlab
Locate the folder where you copied the file
Run plotVTCData 
You will need to provide the following information

The top level folder for the fMRI data you wish to analyse – usually this will end in \fMRI Data\
The initials of the subject whose data you wish to analyse
The scanID for the scan you wish to analyse
The full name and path for a VOI file which contains VOIs you wish to check the time course for.

Example

plotVTCdata('D:\fMRIDataZK04\RelativeDepthLabel\fMRI Data\',...
%'LMP','zk11_252','all_ROIs_combined.voi');

The results should look like the figure below.

[image: C:\Users\dexterm\AppData\Local\Microsoft\Windows\Temporary Internet Files\Content.Word\V3A - No spikes (n_HB_zk09_038_V3a).png]
If your results show a “spike” in the activation at the beginning of a run (see figure below) this might indicate that the data at the beginning of the run is suspect and you should consult Matthew or Zoe for guidance.


[bookmark: _Toc366483425]Multi study General Linear Model

[bookmark: _Toc366483426]Fixed Effects (FFX) Analysis for multiple runs within subject

You will need to have created RTC files for each VTC you wish to analyse – remember to include the motion correction predictors.

· From the Analysis menu choose General Linear Model: Multi Study…
· Click Add to list and add the relevant VTC and RTC files
· Ensure z-transform is checked
· Click Save MDM so you can re-run the GLM if necessary later
· Click GO
· Overlay the GLM and create VMP as for a single subject

[bookmark: _Toc366483427]Random Effects (RFX) Analysis for multiple runs between subjects


Firstly create the RTC file for each individual VTC for all runs and all subjects – remember to include the motion correction predictors. In order to distinguish between different subjects BrainVoyager requires that the VTC files are prefixed with the subject initials.

For RFX Analysis, BrainVoyager will initially perform a single subject GLM for each subject which will generate a t-map for all subjects. A second GLM is then performed on the t-maps.

Create the MDM file as for FFX Analysis but include RTC’s and VTC’s for all subjects. 

Ensure the RFX GLM is checked this will automatically check %-transform and separate subject predictors.

To run the RFX GLM

· From the Analysis menu choose General Linear Model: Multi Study…
· Click Add to list and add the relevant VTC and RTC files
· Ensure %-transform is checked
· Click Save MDM so you can re-run the GLM if necessary later
· Click GO

To analyse the results

· On the Analysis menu choose Overlay General Linear Model …

 The dialog will display predictors for all subjects order by the prefix on the VTC files (see above).

· Set the contrast you want on the first subject only.

The same comparison will automatically be checked for each subject
Save the GLM and CTR files in an appropriate place
Click OK

· Overlay the VMP as for a single subject

[bookmark: _Toc366483428]Using Masks with the GLM

It is possible to limit the number of voxels which are considered in a GLM by using a mask file. By limiting the number of voxels you can increase the statistical power of the GLM.

For a single study GLM you can specify the mask to use by clicking Options and specifying the mask file on the Masking Functions tab.

For multi-study GLM’s you can specify the mask by clicking Options and specifying the mask file directly on the dialog.

[bookmark: _Toc366483429]Artifact  identification and correction

This step is important to clean the bad data. Before, you looked at the raw time course and motion figures, now you will make notes and decide what to take out. The procedure to decide to take out or to keep the data is the similar, but the second step (to actually remove the bad data from analysis) is different for GLM and MVPA analysis.

[bookmark: _Toc366483430]Identifying and deciding what to do with the artifacts

Check the motion plot for each run. If there is sharp motion over 1 mm or step motion that caused an overall change above the size of a voxel, it is recommended to correct this using one of the following options: 1) exclude the run; 2) cut the data. If the motion is present mostly towards the end or beginning of the run, they can be cut. If you have to exclude more than 40% of the trials, exclude the whole run. If the motion goes up and down more than a voxel size, better to exclude the run. Before you do anything, just write down the “bad” volumes.

Any unusual motion, even if it is less than a voxel size, must be checked against the time course. Sometimes, small movement can cause artifacts in the time course, so the data has to be cut on those as well. In addition, sometimes the variance goes higher than .10 because of edge artifacts towards the end of the run. These spikes can spoil the analysis, especially for MVPA, since the first step is a z-score normalization (these spikes influence the mean and standard deviation of the time series which can bias this normalization). In such case, it’s also recommended to remove this data. Write down the Subject/Session/Runs/volumes to remove (use the provided table to make notes).

[bookmark: _Toc366483431]Artifact correction

Important: Make a copy of the VTCs, SDMs and PRTs before cutting. 

Save the copies out of the folder you’re working (for example, if you are working on session zk12_173, make another folder called zk12_173 – Copy). So the folder with the session will contain only the cut files, and the Copy will contain the intact. It’s also recommended to exclude the folders with the runs that were excluded, for the sake of saving space and also to avoid including runs that have to be excluded from analysis. The intact folder will contain all of it, so it’s possible to get them if necessary.

Removing the volumes with artifacts

This step differs depending on whether you are correcting for GLM or MVPA. 

Bear in mind that if you have to do both, you will do the MVPA procedure on the non-smoothed data. 

Important: if the volumes to be cut are in the middle of the run, you will hide the volumes you want to cut from the PRT only. 

The other files will be intact (VTCs, SDMs). To do so, go to the PRT of the given run and delete the blocks or trials that follow in the volumes you want (remove the full trial or block, never cut in the middle of it). 

If your artifacts are in the beginning or end of the run, you will actually CUT the PRTs, VTCs and SDM files in a way that they are all very well matched.   

IMPORTANT: DON’T CUT THE RUN IN VOLUMES THAT FALL WITHIN A BLOCK OR TRIAL 
For example, If you have to cut from volumes 1 to 13 and your trial finishes at volume 15, cut it till volume 15. Be careful. Follow the script, writing and making a register of everything you’ve done with the data, making one cell in Matlab (%%) for each participant. Make a system for deleting it, so you remember and don’t redo those steps (doing it twice would spoil the data completely). See the example below (cutting the 20 first slices of run 1):

%% IC
%Pre-test
%run 1
% omit volumes 91:110 from the PRTs
% then do the cutting as follows
CutPRTtimeseries('\IC\zk12_017\ROI_vtc\prt',20,0,'IC_1');
CutVTCtimeseries('\IC\zk12_017',20,0,'03_zk12_017.SeqHMB1_SCCAI_3DMCT_LTR_THP3c_TAL'); %cut non-smoothed vtc
CutVTCtimeseries('\IC\zk12_017',20,0,'03_zk12_017.SeqHMB1_SCCAI_3DMCT_LTR_THP3c_SD3DSS5.00mm_TAL'); %cut smoothed vtc
CutSDMtimeseries('\IC\zk12_017',20,0,'03_zk12_017.SeqHMB1_SCCAI_3DMC');

The first argument is the directory the file is in. The ‘CutPRTtimeseries’ will cut the PRT file. The second argument is how many volumes to cut from the start (20 in our example), the third one is how many to cut from the end (zero in the example), the last one is the PRT filename (careful to not delete the wrong run. 

ATTENTION: if you are cutting volumes in the beginning but also deleting volumes in the middle (the ones to delete only in the PRT, first do it and then cut, otherwise the volumes won’t match anymore. 

Make notes in the script, so you can track everything you’ve done for each participant. Also make the notes in the table provided. The other functions are similar to the first, with the inputs: directory, how many to cut from start, from the end, filename.

After you finished the cutting, I recommend you to attach the PRTs to VTCs automatically (that will save you time over doing that in BrainVoyager) as in the following example: 

AttachPRT2VTC('\IC\zk12_017','\IC\zk12_017\ROI_vtc\prt','SCCAI_3DMCT_LTR_THP3c_SD3DSS5.00mm_TAL','IC')

For this function to work you have to have equal number of PRTs and VTCs. Remember to apply the same process to smoothed and non-smoothed data.

[bookmark: _Toc366483432]Advanced  statistical analyses

BrainVoyager has many options for computing the GLM some of which are summarized briefly below.

For more information on these advanced statistics, please see the Advanced Statistics in BVQX.doc file, the BrainVoyager help file and the presentations and other notes in the BrainVoyager FTP Site folder.

[bookmark: _Toc366483433]Confound predictors

Confound predictors – e.g. drift, fourier or discrete cosine functions maybe calculated and added in BrainVoyager to improve the fit.

[bookmark: _Toc366483434]Deconvolution analysis of rapid event-related designs

Rapid event related designs can induce substantial overlap of evoked responses.
In such cases, the HRF model must be very good otherwise statistical sensitivity will be severely reduced
Using the convolution of HRF it is possible to detect effects but response profiles cannot be estimated using event-related averaging due to overlapping responses.

Deconvolution analysis may be used to estimate condition-related response profiles but this requires jittered inter trial intervals – e.g. null events.

[bookmark: _Toc366483435]Serial Correlations

There is a general assumption with the GLM that each data point is measured independently and that residuals are temporally uncorrelated. fMRI data violates this assumption even when there is no true activation (e.g with a phantom).

There are two ways of  accounting for temporal correlations – known as pre-whitening and pre-colouring.

[bookmark: _Toc366483436]ANOVA and ANCOVA

In contrast to a multi-subject RFX GLM where the second-level analysis uses t-maps derived from single subject GLM with RFX ANOVA the mean condition effects are analysed using an ANOVA approach making it possible to model one or more within subjects (repeated measures) factors. In addition it is also possible to model a between subjects factor for multiple groups of subjects.


[bookmark: _Toc366483437]Cortex based functional imaging group analysis

[bookmark: _Toc366483438]Principles of cortex-based functional imaging group analysis


The traditional logic of group fMRI analyses in Brain Voyager is as follows. The information contained in the VTC file for each subject has been mapped into Talairach space, i.e. the voxel time course entries at a specific coordinate in files from different subjects are assumed to represent the same part of the brain when transformed –providing a common frame of reference for all subjects. When specifying a multi-subject GLM only the VTC and RTC files need to be used as input. After specifying contrasts, the result will be a statistical map in Talairach space (VMP file). Using a smoothed, reconstructed cortex representation also in Talairach space as a reference (the mesh), the values in the .vmp file can be overlaid at the topographically correct position.

The logic of cortex-based functional imaging data analysis is quite different. As in the traditional way, the functional data is first transformed into to Talairach space (normal creation of VTC files) for each subject.

However, in order to better align the functional data the reconstructed cortices of all subjects are first aligned to each other anatomically. 

The established correspondence mapping between vertices of the cortices is used to align the subject’s functional data. Thus the functional time course data is first attached to the vertices (nodes) of the cortex meshes by sampling the VTCs at the vertex positions of the folded cortex meshes of each subject, resulting in a mesh time course (MTC file) for each run of each subject’s data. 

In a multi-subject GLM study this mesh time course along with the respective design matrix and the correspondence mapping of the subject’s cortex mesh representation to a group average mesh or target mesh can be used.

[bookmark: _Toc366483439]Cortex Based Alignment

A good match between corresponding brain regions across subjects is important for group-level statistical data analysis. 

Group analysis in Talairach space suffers, however, from a coarse alignment between different brains producing suboptimal, and sometimes even misleading group maps due to extensive spatial smoothing. 

While functional areas do not precisely follow cortical landmarks, it has been shown for areas V1 and motor cortex for example that a cortical matching approach substantially improves statistical group results by reducing anatomical variability. 

BVQX offers a cortical mapping approach to aligning brains using the curvature information of the cortex. Since the curvature of the cortex reflects the gyral/sulcal folding pattern of the brain, this brain matching approach essentially aligns gyri and sulci across brains from multiple subjects.

The essence of cortex based alignment is to produce spherical mappings of the cortex co-aligned across multiple subjects.

BrainVoyager initially inflates each RECOSM mesh to a sphere – the number of vertices on this sphere is the same as that in the RECOSM mesh.

The RECOSM sphere is  then re-sampled to a standard sphere of 40,962 vertices. BrainVoyager also creates a sphere-to-sphere mapping  (SSM) file which maps the vertices of the RECOSM sphere to the standard sphere. 

BrainVoyager in addition creates a non-inflated version of the mesh with the same standard number of vertices and the same curvature information as in the original RECOSM mesh. 

The curvature information for the spherical mesh is saved as a surface map (SMP) in four different resolutions.

Once a standard sphere for each RECOSM mesh has been created, BrainVoyager can use the standard spheres to align cortical structures (gyri and sulci) across subjects – either by aligning to a specified target or aligning all subjects in a group to a dynamic average. 

In order to do this BrainVoyager creates a spherical map for the target in spherical coordinates (this is saved as a PMP file)  in 4 different resolutions – these maps are independent from the resolution of the target mesh and each resolution can be visualised in BrainVoyager on the Target Sphere tab of Cortex-Based alignment.

Aligning one sphere to a specific target is a somewhat manual process whereby alignment at each resolution is carried out sequentially by the user.

Alignment of a group is more automatic with BrainVoyager controlling the alignment at each resolution. Alignment of a group to a dynamic average curvature is also possible.

Once alignment at all resolutions has been achieved, BrainVoyager will save a surface map of the aligned cortices and an SSM file which maps the standardised sphere for each subject to the group target (or dynamically averaged target).

After having performed the alignment it is possible to perform statistical analyses on the spatially aligned cortices.
The traditional logic of group fMRI analyses in Brain Voyager is as follows. The information contained in the VTC file for each subject has been mapped into Talairach space, i.e. the voxel time course entries at a specific coordinate in files from different subjects are assumed to represent the same part of the brain when transformed –providing a common frame of reference for all subjects. When specifying a multi-subject GLM only the VTC and RTC files need to be used as input. After specifying contrasts, the result will be a statistical map in Talairach space (VMP file). Using a smoothed, reconstructed cortex representation also in Talairach space as a reference (the mesh), the values in the .vmp file can be overlaid at the topographically correct position.

The logic of cortex-based functional imaging data analysis is quite different. As in the traditional way, the functional data is first transformed into to Talairach space (normal creation of VTC files) for each subject.

However, in order to better align the functional data the reconstructed cortices of all subjects are first aligned to each other anatomically. 

The established correspondence mapping between vertices of the cortices is used to align the subject’s functional data. Thus the functional time course data is first attached to the vertices (nodes) of the cortex meshes by sampling the VTCs at the vertex positions of the folded cortex meshes of each subject, resulting in a mesh time course (MTC file) for each run of each subject’s data. 

In a multi-subject GLM study this mesh time course along with the respective design matrix and the correspondence mapping of the subject’s cortex mesh representation to a group average mesh or target mesh can be used.

[bookmark: _Toc366483440]Preprocessing for CBA

As a first step, the folded cortex for each subject is morphed into a sphere where ach vertex of the sphere (spherical coordinate system) corresponds to a vertex of the folded cortex – the same number of vertices being present in both.

· Load final_TAL.vmr
· Load the RECOSM mesh
· On the Meshes menu choose Cortex Based Alignment (CBA)
· Select Curvature Tab – check Use linked mesh’s folding pattern and select the RECOSM.srf file as the linked mesh.
· Choose Curvature and then smooth
· Select Make Sphere Tab
· Using the default parameters click Morph
· Once the morphing is complete click Correct

The file will be saved with the suffix _SPHERE.SRF

For each subject the resulting sphere now has to be mapped into a standardized sphere space having the same number of vertices for all subjects.

· On the Meshes menu select Cortex Based Alignment (CBA)
· Select the Sample Sphere Tab.
· Select the_SPHERE.srf  in to Mapping from standard sphere to cortex sphere into the Create Sphere field (usually automatic)
· Select ‘Map std. sphere’
· Save the resulting .ssm (sphere-to-sphere vertex mapping) file

Next from the resultant mapping the reconstructed folded representation (_RECOSM.srf) has to be standardized as well

· Select the respective RECOSM.srf file into the Standard sphere vertex and curvature setting , Folded mesh field
· Select ‘Set std sphere vertices
· 
The respective _RECOSM_SPH.srf file will appear in the  Folded sphere field

Next the curvature characteristic of the folded representation will be mapped onto the sphere

· Select Source Curvature

In the working directory a file with the extension RECOSM_SPH_CURVATURE.smp will be saved.

[bookmark: _Toc366483441]Alignment

Cortex Based Alignment can be performed in 2 different ways:

Alignment of a pair of hemispheres by specifying a target and a source 
Alignment of a group of hemispheres either to a target or a dynamically calculated group average.

In the target approach, one sphere is selected as a target to which all other spheres are subsequently aligned. The target sphere can be derived from one of the group subjects’ brains or from a reference brain. In the dynamic group averaging approach, the selection of a target sphere is not required. In this approach, the goal function is specified as a moving target computed repeatedly during the alignment process as the average curvature across all hemispheres at a given alignment stage.

Alignment of a pair of hemispheres

First a target sphere has to be specified from the curvature representation of the folded vertices
On the Target Sphere Tab

· In the curvature as normal vertex surface map field load the _RECOSM_SPH_CURVATURE.smp from the previous step and select Create PMP. This creates a spherical curvature map representation of the reconstructed cortex, which is displayed in the surface mode window and creates the target curvature file in spherical coordinates (PMP file)

On the Align Pair Tab

· In the Curvature to be aligned with target field load the source _RECOSM_SPH_CURVATURE.smp file
· In the Display options field one can switch between viewing an overlay of both curvature spheres or either target or source
· Select Align. The source curvature map will now be aligned to the target curvature map.
· Select Save Results 

Three files will be created:

· 3D_FINAL_TAL_LH_SPH_ALIGNED.srf, the mesh representation of the outcome of the alignment process to be inspected
· An SSM file with mapping parameters of the same name
· A  VWP file with the visualization settings in the surface module (viewpoint etc.) 

Alignment of a group of hemispheres

The first step is to decide whether an explicit or implicit target approach is desired. If an explicit target approach is chosen, the target has to be specified as under Align Pair and the respective option ticked in the Cortex Based Alignment, Align Group tab. Otherwise the steps are identical to the Moving Average Target Approach outlined below


Moving Average Target Approach

· On the Align Group Tab
· Add the curvature SMP files from all subjects by using the Add button
· Select Align to dynamic group average in the Alignment Mode field
· Select GO
· Three files will be saved for each subject, an SSM file with  the mapping from the RECOSM_SPH to the group average called GROUPALIGNED.ssm, its inverse called GROUP-ALIGNED_INV.ssm and a view parameter file VWP.



[bookmark: _Toc366483442]Cortex based functional imaging data analysis

As outlined above, prior to entering the functional data into a group GLM, the functional data has to be sampled at the position of the vertices of the reconstructed and spherical standardized mesh. Then these entries in the mesh time course are mapped to corresponding points for all subjects using the GROUPALIGNED.ssm files created during group alignment. A multi subject GLM is computed and the results can be shown as an average reconstructed cortex representation.


Create a mesh time course (MTC)

A mesh time course samples the volume time course at the vertex positions of the specified mesh. In this case the RECSOM_SPH which has the same number of vertices for all subjects

· Load _final_TAL.VMR
· Link the VTC file to be sampled from
· Load the respective RECOSM_SPH.srf mesh
· On the meshes menu select Mesh Time Courses …
· On the Create MTC from VTC tab  select Create MTC

The respective MTC file will be saved in the working directory

Generating an average folded cortex representation in standardized spherical space

· Load _final_TAL.VMR
· On the Meshes menu choose Load Mesh and load any of the _RECOSM_SPH.srf meshes
· On the Meshes menu choose Cortex Based Alignment (CBA)
· On the Options Tab
· Check Average curvature of subject spheres
· Select shape (not curvature) at the bottom
· Using Add select the RECOSM_SPH and GROUPING.ssm files of the subjects to be averaged
· Select ‘Average’
· Save .SRF as SPH_Average file

Computing a surface based multi-subject GLM

· Load_TAL.vmr
· On the Meshes menu choose Load Mesh and load any SPH_Average.srf
· On the Analysis menu choose General Linear Model: Multi Study …
· Select the desired SSM, MTC., and RTC files
· Use computed GLM as usually


[bookmark: _Toc366483443]Manual Inhomogeneity correction

Load the _RAW.VMR file.
Before doing anything else you must save a 16-bit version of this file, to do this:
On the Volumes menu choose V16 Tools, Inhomogeneity Correction
Click Save V.16 and save the file with the same name as the VMR but with the extension V16.
Click Close

[bookmark: _Toc366483444][bookmark: _Toc62411054]Clean up / Brightness and Contrast

To make the subsequent inhomogeneity correction steps easier the brightness and contrast of the VMR can be adjusted and any noise found outside the head can be removed. The aim of adjusting the brightness and contrast is to change the intensity of the white matter so that using the suggested inclusion ranges for segmentation (see below) will select the majority of the white matter. The contrast setting should always be set to 60 and the brightness should only need to be adjusted between 47 and 49. The brightness should be adjusted within this range until the least bright white matter has an intensity around 120.

To adjust the brightness and contrast

· Load _RAW.vmr 
· On the Options menu choose Contrast and Brightness
· Adjust the contrast and brightness sliders so that contrast = 60, brightness = 47-49
· Save the changes back to the VMR 

To remove noise found outside the head from the image

· Load _RAW.vmr 
· Load _RAW.v16
· Open 3D Volume Tools
· Click somewhere in white matter of the brain
	
On the Segmentation tab under Value Range

· Set Min:  35 (8channel coil) 
· Set Max: 255
· Click Grow Region

The whole head should now be blue.

· Click Marked 

This will set the intensity of all unidentified voxels to 0 thus excluding the background around the head.

· Save the VMR with the suffix _CLEAN.VMR


[bookmark: _Toc366483445]Inhomogeneity Correction

Initial segmentation of white matter. Due to inhomogeneities in the magnetic field strength within the brain and distance from the receive coils the intensity of the signal from different areas of the brain is not uniform. As a result the white matter found near the centre of the brain has a higher intensity than that found towards the edge of the brain. By correcting this inhomogeneity the intensity of white matter throughout the brain can be restricted to a narrow range of values making the subsequent white matter segmentation steps more accurate.

Great care has to be taken in this step if the anatomy will be used for cortex reconstruction. All values are proposals and will have to be adjusted for individual brains. If problems occur, changing the brightness and contrast settings in the Volumes: V16 Tools, Inhomogeneity Correction menu might help. 

· Load _CLEAN.vmr (covering white matter only)
· On the Volumes menu chooseV16 Tools, Inhomogeneity Correction
· Load V.16: xx_zk0x_xx.3d_raw.v16
· Click Close

· Open 3D Volume Tools
· Click somewhere in white matter of the brain	

On the Segmentation tab under Value Range

· Set Min:  120 (8channel coil) 
· Set Max: 200

· For excluding ‘no-brain’ – areas, set the z-value of the bounding box appropriately – the z value should be just below the bottom of the temporal lobes. 
· Click Grow Region
· Increase the Max value and click Expand (little gaps of selection are filled locally without filling the whole image – use the zoom tools  (window needs to be non-maximized) and/or  ctrl Right-Click to zoom up on the image)


· On the Volumes menu choose V16 Tools, Inhomogeneity Correction
· Under  Inhomogeneity Correction Click Presegmentation-based
· Save the V.16 with the suffix homog1.V16
· Click Close
· Save the VMR with the suffix homog1.VMR

Repeat the inhomogeneity correction twice (if necessary) – don’t forget to save and load the V16 files 

For the second time set the Value Range to 130-170 and save V16 and VMR with the suffix homog2

Third time use Value Range 140-165 and save with the suffix homog3.

After completing inhomogeneity correction save the final version of the VMR with the suffix _final.VMR 


 
[bookmark: _Toc366483446]Talairach Coordinates for Well Defined Functional Areas

[bookmark: _Toc366483447]Lateral Occipital Complex
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	Right
	 

	Reported by
	x
	y
	z
	x
	y
	z

	Zoe's table (1)
	-39.7 (9)
	6.7 (13)
	38.3 (3)
	47.2 (8)
	4 (1)
	35 (4)

	Zoe's table (2)
	-49 (4)
	8 (4)
	12 (5)
	50 (5)
	6 (6)
	14 (5)

	 Bestmann et al. (2005) Neuroimage
	-49
	2
	17
	54 
	0
	13 

	 
	 
	 
	 
	 
	 
	 



[bookmark: _Toc366483472]FEF

	 
	 
	Left
	 
	 
	Right
	 

	Reported by
	x
	y
	z
	x
	y
	z

	Orban et al. (2003) Neuropsychologia
	-33
	0
	63
	39
	0
	60

	 
	-42
	0
	51
	48
	3
	48

	Sterzer et al. (2002) Neuroimage
	-32
	4
	66
	38
	0
	60 

	Heekeren et al. (2006) PNAS
	-46
	-2
	36
	 
	 
	 

	 
	 
	 
	 
	 
	 
	 



[bookmark: _Toc366483473]Medial FG (SEF SMA)

	Medial FG (SEF, SMA)
	
	
	
	
	
	

	 
	 
	Left
	 
	 
	Right
	 

	Reported by
	x
	y
	z
	x
	y
	z

	Zoe's table (1)
	-5.7 (3)
	-11 (4)
	56.3 (3)
	 
	
	 

	Pernet et al. (2004) NeuroImage
	-4
	-1
	48 (BA9)
	4
	-7
	50 (BA6)

	 
	 
	 
	 
	6
	4
	48

	Heekeren et al. (2004) Nature
	 
	 
	 
	10
	68
	0

	SEF
	
	
	
	
	
	

	Heekeren et al. (2006) PNAS
	 
	 
	
	4
	18
	44

	Grosbras et al. (1999) Cereb Cortex
	-8 (4)
	-12 (10)
	51 (3)
	4 (6)
	-34 (3)
	48 (0)

	O'Driscoll et al. (1995) PNAS
	-1.9
	9.8
	52
	 
	 
	 

	O'Sullivan et al. (1995) NeuroReport
	-2
	8
	52
	8
	-12
	60

	Sweeney et al. (1996) J Neurophysiol
	-2
	-18
	56
	8
	-22
	64

	Doricchi et al. (1996) Exp Brain Res
	 
	 
	 
	18
	2
	48

	 
	 
	 
	 
	12
	-2
	48

	Law et al. (1997) Acta Physiol Scand
	-4
	-8
	52
	0
	-2
	56

	Dejardin et al. (1998) Eur J Neurosci
	-6
	-16
	56
	 
	 
	 

	Luna et al. (1998) Cereb Cortex
	0
	0
	54
	0
	0
	48

	Petit et al. (1996) J Neurosci
	 
	 
	 
	8
	4
	52

	Nachev et al. (2005) Current Biolog.
	-4
	0
	70
	
	
	

	 SMA
	 
	 
	 
	 
	 
	 

	 Lee et al. (1999) Neuroimage
	 
	 
	 
	 
	 
	 

	 - Early motor
	-6 
	12
	52
	6
	10
	52

	 - Mid motor
	-2
	8
	58
	4
	2
	64

	 - Late motor
	-2
	-2
	60
	4
	-2
	62

	Chan et al. (2006) Neurosci. Lett.
	-4
	-4
	54
	
	
	



[bookmark: _Toc366483474]DLPFC

	 
	 
	Left
	 
	 
	Right
	 

	Reported by
	x
	y
	z
	x
	y
	z

	Zoe's table (1)
	-38 (8)
	27.5 (6)
	22 (6)
	41 (5)
	29 (11)
	16.2 (12)

	Grossman et al. (2002) NeuroImage
	-52
	16
	24
	 
	 
	 

	 
	-28
	28
	44
	
	
	 

	Heekeren et al. (2004) Nature
	-24
	25
	32
	 
	 
	 

	 
	-22
	27
	32
	 
	 
	 

	Heekeren et al. (2006) PNAS
	-23
	30
	33
	 
	 
	 

	 
	 
	
	
	 
	
	 



[bookmark: _Toc366483475]Thalamus

	 
	 
	Left
	 
	 
	Right
	 

	Reported by
	x
	y
	z
	x
	y
	z

	Aizenstein et al. (2000) J Cog Neurosci
	 
	
	
	10
	-10
	14

	Pernet et al. (2004) NeuroImage
	-10
	-19
	12
	 
	 
	 

	Heekeren et al. (2004) Nature
	 
	 
	 
	10
	-19
	5

	 
	 
	 
	 
	12
	-1
	9

	 
	 
	 
	 
	 
	 
	 



[bookmark: _Toc366483476]Caudate

	 
	 
	Left
	 
	 
	Right
	 

	Reported by
	x
	y
	z
	x
	y
	z

	Pernet et al. (2004) NeuroImage
	-8
	6
	5
	-10
	4
	3

	Heekeren et al. (2004) Nature
	-8
	6
	13
	22
	-18
	21

	 
	 
	
	
	 
	
	 






** Zoe's table (1) is the table from Zoe’s previous study at Tubingen. 













[bookmark: _Toc366483477][bookmark: OLE_LINK11][bookmark: OLE_LINK12]
Creating and Using Grey Matter Masks

For each subject a grey matter mask can be created which allows analysis to be performed only on those voxels in a VTC file that are labeled as grey matter. 

To create a whole-brain grey matter mask for an individual subject:

Load the subject’s TAL VMR file and link the VTC file that you wish to create the grey matter mask for.
Load the subject’s left hemisphere white matter boundary mesh (the file has the suffix _LH_RECOSM.srf)
Select ‘Add Mesh’ from the ‘Meshes’ menu and load the subject’s right hemisphere white matter boundary mesh (the file has the suffix _RH_RECOSM.srf).
You should now see both hemispheres in the mesh window. Select ‘Merge meshes’ from the ‘Meshes’ menu and save the mesh.
Select Create Cortex Mask from the Meshes menu, select the resolution to create the mask at – 3x3x3 for normal and 1x1x1 for high resolution.
 Click Restrict within VTC boundaries and select a VTC from the subject in question.
Click GO.
Save the grey matter mask. 

To create an average grey matter mask for a group study:

Select ‘Combine cortex-based masks…’ from the ‘Analysis menu’
Add the individual grey matter masks as created above.
Choose a name for the average mask and save it by clicking ‘Go’.

To use the grey matter mask you have created for an individual subject in a single GLM:

Open the GLM dialog as usual.
Select ‘Options’
At the top of the ‘Options’ dialog there is a panel labeled ‘cortex-based statistics’, click ‘Enable’ to select the grey matter mask.
Perform the GLM as normal.

To use the grey matter mask in a multi-study:

Open the multi study dialog as usual.
Select ‘Options’
Select the grey matter mask in the ‘cortex-based statistics’ panel and select ‘Enable’.
Perform the GLM as normal.


It is also possible in the case of scans which are not of the whole brain to limit the mask to only the functional data contained in the VTC. To do this create a whole-brain grey-matter mask as above and then use the Matlab script limit_gmm_to_vtc as follows:

The script generates a new grey matter mask based on the initial mask and VTC provided. Only voxels which both appear in the initial mask and have data in the VTC are included in the new grey matter mask.

This scripts requires that the BVQXtools scripts are available in the Matlab path.

Usage: 
limit_gmm_to_vtc(grey_matter_mask_file, vtc_file, output_file)

The script reads in the specified grey matter mask and the VTC, performs the masking, and saves the result in the output file.

[bookmark: _Toc366483478]Advanced Segmentation Tools 
Before running the single-subject cortical thickness analysis the brain tissues must be segmented using the Advanced Segmentation Tools in the Volumes menu. Most of these steps can take a very long time and give you the false impression that your computer has stalled. 
Anatomical pre-processing: Advanced segmentation is most successful when only one inhomogeneity correction has been carried out.
[image: AdvSeg_Preparation1]
Open xx_zk0x_xx.3d_final_TAL.vmr.
Volumes -> Advanced Segmentation Tools
Preparation tab:
Click  To 0.5 mm – resamples the brain to half millimetre resolution
The Current resolution field should now reflect this change:
[image: ]
Click Peel Brain – should remove most of the skull tissue
Click Label as WM – labels subcortical structures in light grey.
The subcortical structure mask can ‘leak’ beyond the white matter and outside of the brain. If this occurs, Brain Voyager suggest two solutions: 1) plug the site at which the mask leaks with a thick pen (it’s normally the third ventricle) or 2) Fill the leaking ventricle by region-growing low intensity values (i.e. 0-50) and substitute the selected voxels with intensities in the white matter. I have yet to see either of these solutions so simply fix the problem.
Click Remove – removes most of cerebellum and other lower structures 
	It is very important that the above steps are done in the specified order.
[image: ]
Click Enhance – enhances tissue contrast ever so slightly
[image: ][image: ]
WM-GM Border tab:	
The Input / output files fields should now contain the file names shown above.
	Click “Calculate” – generates magnitude and gradient files (can be loaded)
[image: ]
Click GO – (very slowly) generates the white-grey matter boundary 
The white matter as derived from global segmentation is shown in blue. The voxels found through the adaptive local segmentation, that would normally be missed, are shown in green. 

[image: ]

	Click Polish – smoothes the boundary
[image: ]

[image: ]

GM-CSF Border tab:
The Input / output files fields should now contain the file names shown above.
	Click Dilate to CSF – finds the outer boundary of the grey matter

	Click Polish – smoothes the GM-CSF boundary

The final result should look something like this:

[image: ]

[bookmark: _Toc366483479]Cortical Thickness Analysis

Cortical thickness analysis is first performed on individual brains. Subsequently, it can be used in combination with cortex-based alignment to conduct group analysis and patches-of-interest (POI) analysis (eg. of anatomical landmarks, Brodman areas etc.). This section concerns the single-subject thickness analysis.

Open xx_zk0x_xx.3d_final_TAL_0.5mmISO_BRAIN_WM_GM.vmr

Volumes -> Cortical Thickness Measurement


[image: ]

Click GO – calculates the cortical thickness VMP and overlays it onto the brain

The colour map for this should already be set, however, if at a later stage you want to reload the thickness VMP (…_WM_GM_Thickness.vmp) you will also have to reload the colour table Thickness.olt via Options -> Statistical Map Look-up Table.

[image: ]

A sign that the measurement worked is that the posterior bank of the central sulcus should be very thin, whereas the anterior bank should be thicker. This probably depends on the pulse sequence used for the anatomical. I have not yet observed such a clear case.
Close the VMRs.

Open xx_zk0x_xx.3d_final_TAL_0.5mmISO_BRAIN_WM_GM.vmr

Analysis -> Overlay Volume Maps

	Load VMP:
 xx_zk0x_xx.3d_final_TAL_0.5mmISO_BRAIN_WM_GM_Thickness.vmp

Tick the boxes for Cortical Thickness and leave others blank.

	Uncheck Show negative

	Click Update VMP

Options -> Statistical Map Look-up Table.
	
Load OLT:	Thickness.olt


Go to Surface module.

Open xx_zk0x_xx.3d_final_TAL_LH_inflated.srf

Meshes -> Mesh Morphing

	Use information from file: 	xx_zk0x_xx.3d_final_TAL_LH_RECOSM.srf

Meshes -> Cortical Thickness Analysis

	Make sure that the Thickness VMP file is set to:
	xx_zk0x_xx.3d_final_TAL_0.5mmISO_BRAIN_WM_GM_Thickness.vmp

	And the WM SRF file is set to:
	xx_zk0x_xx.3d_final_TAL_LH_inflated.srf

	Interpolation for streamline should be set already to Trilinear interpolation.

	Click GO

This results in a statistical surface map of cortical thickness values which is already saved:

xx_zk0x_xx.3d_final_TAL_LH_inflated_Thickness.smp


In a good case the thin posterior bank of the central sulcus should be clearly visible:

[image: ]


See in comparison a “real” brain:

[image: ]

[bookmark: _Toc366483480]False Discovery Rate (FDR)


FDR is the proportion of false positives among those tests for which the null hypothesis is rejected. To control the FDR, a procedure specifies a rate q (0 < q < 1) and ensures on average the FDR doesn’t exceed q. The procedures are as follow:

1) Select a desired q (e.g. 0.05)
2) Order p values from the statistical test from smallest to largest:
		p(1) ≤ p(2) ≤  … ≤ p(v) 
3) Let r be the largest i for which
p(i) ≤ (i/v).(q/c(v))
4) Declare voxels v(1), …, v(r) active, as the threshold of the test statistics is set to be p(r).

For reference, see Genovese et al.(2001) NeuroImage 15, 870-878.

In practice, FDR is a less conservative approach comparing to Bonferroni correction, which is too strict for many cases. We can easily control the FDR in BV QX. When you fit your data to GLM model, 

[image: FDR]

1)  For single study
	- Load TAL.vmr
	- Link VTC file
	- ANALYSIS - General Linear Model: Single Study
		- load RTC file
		- click Options…, click FDR…, check Enable and choose q value
		- click OK, click OK
		- click GO
	- ANALYSIS - Overlay General Linear Model
		- set contrast and OK
	- Change the threshold as usual, and you can see the corresponding q(FDR), see figure above.

2) For multi study
	- Load TAL.vmr
	- ANALYSIS - General Linear Model: Multi Study
		- add VTC files to the list and run it as usual
	- ANALYSIS - Overlay General Linear Model
		- set contrast
		- click Options…, click FDR…, check Enable and choose q value
		- click OK, click OK
	- Change the threshold as usual, and you can see the corresponding q(FDR).

Note: FDR might not work for random effect analysis because it is most likely to have no voxel pass the threshold we set (usually q(FDR)=0.05). For this case, FDR is not the optimal approach for correcting false positives. 

[bookmark: _Toc366483481]Temporal Serial Correlations

One assumption of GLM is that the residuals of any pair of data points within a voxel time course have to be uncorrelated. Because the hardware introduces positive serial correlations, though in practice, the fitted model is roughly the same with or without serial correlations, the statistical significance is still overestimated (too good).

In BV, there is a two steps procedure to remove the serial correlation and refit GLM:

1) GLM fitted without considering serial correlation, and this fit provides residuals by subtracting the model from the data;
2) Second, these residuals are analyzed by computing the one-lag auto-correlation (AR(1)), the time course is then adjusted to remove the detected serial correlations.

When you fit your data to GLM model, 

1)  For single study
	- Load TAL.vmr
	- Link VTC file
	- ANALYSIS - General Linear Model: Single Study
		- load RTC file
		- click Options…, click Residuals…
- check Remove AR(1) and refit GLM
- check Create AR(1) map before correction
- check Create AR(1) map after correction
		- click OK, click OK
		- click GO

2) For multi study
	- Load TAL.vmr
	- ANALYSIS - General Linear Model: Multi Study
		- add VTC files to the list 
		- click Options…
- check Remove AR(1) and refit GLM
- check Create AR(1) map before correction
- check Create AR(1) map after correction
		- click OK
		- click GO

[bookmark: _Toc366483482]BVQX File Suffix Interpretation

_3DMC_  	3d Motion Corrected

_pp_ 	2d Temporally Smoothed

_FTS- 	3d Temporally Smoothed e.g. "_FTS-3-126" is frequency domain temporal smoothing with high pass of 3 cycles and low pass of 126 (note: not available from GUI )

_FSS- 	3d Spatially Smoothed in frequency domain e.g. "_FSS-1-14" is spatial smoothing with high pass of 1 voxels and low pass of 14 voxels

_MIA_ 	Mean Intensity Adjusted

_SCpoI 	Slice scan Time corrected. The letter p codes the scan interpolation: p=S signifies sinc interpolation and p=L linear interpolation. The letter o codes scan slice order: o=A for ascending and o=D for ascending e.g SCLD. An optional final character, I, indicates that the scan order was interleaved e.g. SCLAI (incorrectly described in help)

_SD3DSS 	3d Spatially Smoothed in Spatial Domain e.g. SD3DSS4.00mm is spatial smoothing with a Gaussian kernel with FWHM of 2.00 mm while SD3DSS5.12px specifies a Gaussian with FWHM of 5.12 pixels

_LTR_ 	Linear Trends Removed

_THP 	Temporally High Pass filtered e.g. LTR_THP3c specifies a filter of 3 cycles in time course, THP1.00Hz specifies a filter of 3 Hz, and THP3.00cp is a filter of 3 cycles/point

_TDTS 	Temporally smoothed in the time domain e.g. TDTS0.3dp is temporally smoothed with a Gaussian kernel with FWHM of 3 data points, and TDTS0.9s is FWHM of 0.9 seconds

[bookmark: _Toc366483483]The Visual Angles of the Eccentricity rings at BUIC

(Distance of eye to screen: 62cm)


1		114 pixel		 4.65 deg


2		139 pixel		 5.66 deg


3		169 pixel		 6.88 deg


4		198 pixel		 8.06 deg


5		221 pixel		 8.99 deg


6		277 pixel		11.26 deg


7		336 pixel		13.64 deg


8		400 pixel		16.20 deg



400 pixel = 16.20 deg 
400 pixel = 17.6 cm on the screen
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4. Analyzing Functional Data
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Table 2. Talairach coordinates of visual area ROIs

Visual
Hemisphere _arca x Mean (SD) _y Mean (SD) = Mean (SD)
Left Vis —65(86)  —9L4(T) 19(97)
vii —65(76)  —828(1.7) -5(1.1)
Vs -11(96) (64) 7.6 (10)
Vi ~103(74)  -793(16)  —102(5.5)
V3 ~166(10.2) (53) 10.4(11.9)
vp ~189(82)  —T86(8) ~136.7)
VIA -212(93)  -80.1(43) 165 (11.1)
Vi -269(73) -T4T(8D  -121(6.0)
MT+  —459(75)  -70.1(52) 18(82)
Right Vis 10.4(9) ~898 (10) 63(68)
vii 82(15)  -831(57) ~19(69)
Vs 112(86)  —93.4(6.1) 10.7(9.9)
Vi 88(78)  —T85(7) ~5.5(4.6)
V3 182(109) 926 (6.1) 1303)
vp 155095  -B5(66) 10747
ViA 227(10) —88.3 (5.6) 165 (10.5)
Vv PO  -TAT62) 113 (52)
MT+ 45581  —65.9(19) ~09 (6.5)
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Table 1 Group analysis: activation sites in left and right hemispheres. LG Lingual gyrus, ant/PS anterior intraparietal sulcus, occIPS oc-
cipital intraparictal suleus, FG fusiform gyrus, SFS superior frontal sulcus

Left hemisphere Right hemisphere

Activation site X y z Z-score  Corrected X y z Z-score  Corrected
P-value P-value

hMT/VS 4. 2 <0.0001 6 <0.0001

hV3A 24 10 <0.0001 90 10 0.044

LOS/KO -3 4 <0.0001 86 2 0.048

LG 20 -8 <0.0001 76 -10 <0.0001

antlPS =30 52 <0.0001

ocelPS -26 26 <0.0001

FG 40 -12 <0.0001

SFS 56 0.002 28 -6 60 773 0.037
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Table 1
Motion sensitive regions in human cerebral cortex

Region  Left hemisphere Right hemisphere

x y oz Zsoe x y oz Zseore
BMTNS+ =51 72 0 687 51 —69 3 730
hV3A -7 90 12 727 33 8T 0 636
LOSKO —42 —81 6 596 42 —81 6 616
Ling —27 90 -9 552 15 93 -9 647
VIPS -7 -T2 30 53 30 -8 27 604
POIPS  —I8 —72 54 510 24 75 45 504
DIPSM  —15 —63 60 567 18 —60 63 597
DIPSA  —36 —48 60 657 39 —36 54 423
FEFI -3 0 6 53 30 0 60 534
FEF2 -2 0 51 524 48 3 48 513
PIC -2 -3 2 508

STS -5 51 12 434

Fus 30 —66 —12 561
cing 15 221 30 478

Fus: fusiform cortex: cing: cingulate cortex.

to these two regions (Tootell et al., 1997). In the present
experiments, we used, however, high contrast stimuli and
whole brain imaging. The other two occipital motion sen-
sitive regions observed in our experiments are located in
lingual gyrus and around the lateral occipital sulcus (LOS).
Retinotopic mapping has shown that the lingual region cor-
responds to ventral V3, including in some instances ventral
V2 or ventral V4 (Sunaert, van Hecke, Marchal, & Orban,
2000; Vanduffel et al., 2002). The LOS region is close to the
kinetic occipital (KO) region which is also sensitive to sim-
ple translation (Rees, Friston, & Koch, 2000; van Oostende,
Sunaert, van Hecke, Marchal, & Orban, 1997), hence the
descriptive label LOS/KO used in the human reports.
There is a prominent motion activation in a string of re-
gions along the IPS. Proceeding from occipital cortex to the

good agreement in both studies (compare Table 1 with Table
2 of Sunaert et al., 1999).

3.2. Motion sensitivity in monkey cortex: translating
random dots

Fig. 2 provides an overview of the motion sensitive re-
gions in the macaque. These regions include V2 and V3,
located in the lunate and inferior occipital sulci, MT/VS,
FST, and MSTv, located in the superior temporal suleus,
VIP located in the intraparictal sulcus and FEF, located in
the arcuate suleus (Vanduffel et al., 2001). In one monkey,
activation of a retroinsular region was observed.

Comparison with the human activation pattern reveals
two important findings. First three of the four arcas of the
MT/VS complex are activated by random dot motion and
likely correspond to the hMT/V5+ activation observed in
humans. These three arcas include MT/VS itself and FST
and MSTv (Fig. 3). In particular, the FST activation matches
that of MT/VS itself in strength. Hence, assumptions based
on single-cell recordings that the main components of the
human MT/V5 complex are the homologues of MT/VS and
MSTd (Dukelow et al., 2000; Huk, Dougherty, & Heeger,
2002; Morrone et al., 2000) are not confirmed by our
results.

Second, the number of motion sensitive regions is reduced
in the monkey compared to humans. In addition to the almost
classical absence of motion sensitivity in V3A (Tootell et al.,
1997; Vanduffel et al., 2001), motion sensitivity tested with
random dots is reduced in V4 compared to LOS/KO (but
see Tolias, Smirnakis, Augath, Trinath, & Logothetis, 2001).
Furthermore, the involvement of parietal cortex in motion
processing is more restricted. VIP was motion sensitive in
all monkeys, but its sensitivity is weak (Fig. 4).

3.3, 3D structure from motion sensitivity in humans and
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